Oracle E-Business Intelligence Enterprise Data Warehouse Install Guide

Release 11i.6

September 2001
Part No. A90299-01
Send Us Your Comments

Oracle E-Business Intelligence Enterprise Data Warehouse Install Guide
Release 11i.6
Part No. A90299-01

Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this publication. Your input is an important part of the information used for revision.

❏ Did you find any errors?
❏ Is the information clearly presented?
❏ Do you need more information? If so, where?
❏ Are the examples correct? Do you need more examples?
❏ What features did you like most about this manual?

If you find any errors or have any other suggestions for improvement, please indicate the chapter, section, and page number (if available). You can send comments to us in the following ways:

❏ Email: bisdoc_us@oracle.com
❏ FAX: 650-506-7412
   Attn: Oracle E-BI Documentation Group
❏ Postal service:
   Oracle E-BI Documentation Group
   Oracle Corporation
   500 Oracle Parkway M/S 3op1112
   Redwood Shores, CA 94065 U.S.A.
If you would like a reply, please include your name, address, and telephone number.
## Contents

**Send Us Your Comments** ........................................................................................................................................ iii

**Preface** ........................................................................................................................................................................... ix

### 1 Introduction

- Overview of E-Business Intelligence ......................................................................................................................... 2
- Overview of Enterprise Data Warehouse .................................................................................................................... 2
- E-Business Intelligence Suite Architecture ......................................................................................................................... 4
  - Enterprise Data Warehouse Architecture ............................................................................................................. 4
  - Source System Components ................................................................................................................................. 5
  - Target System Components ................................................................................................................................ 5

### 2 Installation Tasks

- Overview of Installing EDW ........................................................................................................................................ 2
- Verifying Prerequisites .................................................................................................................................................. 4
  - Hardware Prerequisites .......................................................................................................................................... 4
  - Source Systems ...................................................................................................................................................... 4
  - Warehouse .............................................................................................................................................................. 4
  - Software Prerequisites ........................................................................................................................................ 4
  - Source Systems ...................................................................................................................................................... 5
  - Warehouse .............................................................................................................................................................. 5
  - Tablespace Prerequisites .................................................................................................................................. 6
3  Upgrade Tasks

   Overview of Upgrading EDW ................................................................................................. 2
   Back Up Source Systems and Warehouse ................................................................................ 3
   Verifying Prerequisites ........................................................................................................... 4
Hardware Prerequisites .................................................................................................................. 4
Source Systems ............................................................................................................................. 4
Warehouse ................................................................................................................................. 4
Software Prerequisites .................................................................................................................. 4
Source Systems ............................................................................................................................. 5
Warehouse .................................................................................................................................... 5
Tablespace Prerequisites................................................................................................................ 6
  Database Schema Tablespace ..................................................................................................... 6
  OWB Repository Tablespace ..................................................................................................... 6
Upgrading the Enterprise Data Warehouse on Source and Target Systems ................................................................. 7
  Apply Patches to Warehouse .................................................................................................... 8
  Apply Patches to Source Systems ............................................................................................ 11
    Applying patches to Release 11i source systems ................................................................. 11
Upgrading Oracle Warehouse Builder Repository ......................................................................................... 13
Loading EDW Metadata .................................................................................................................. 13
  Load EDW Metadata ................................................................................................................. 13
Creating the EDW End User Layer and Importing EDW Workbooks ......................................................... 15
  Create the End User Layer ....................................................................................................... 15
  Generate the EDW End User Layer EEX File ........................................................................ 16
  Import the EDW End User Layer EEX File ............................................................................ 18
Configuring Security .......................................................................................................................... 20
  Grant Users/Responsibilities Access to Oracle Discoverer 4i User, or Administration Client .... 21
  Grant Users/Responsibilities Access to Business Areas .......................................................... 22
  Transfer EDW Discoverer 4i Contents to Windows NT Client with Oracle Discoverer 4i Administration Client ................................................................................................................. 23
  Grant Users/Responsibilities Access to Workbooks ............................................................... 25
  Define Default Profile Options ................................................................................................. 26
Reallocate Tablespace ....................................................................................................................... 26
Backup Source Systems and Warehouse ............................................................................................ 27

Index
Welcome to Release 11.6 of the Oracle E-Business Intelligence Enterprise Data Warehouse Install Guide.

This guide describes the installation steps for the Oracle E-Business Intelligence Enterprise Data Warehouse. It contains technology components, system requirements, and task and reference information.

**Note:** This manual, and any other documentation associated with this release, was current at the time it was published and released. However, we make enhancements to Oracle Applications products and respond to user needs on a continuing basis. Always check Oracle MetaLink for the most up to date information.

**Audience**

If you are responsible for installing Oracle E-Business Intelligence Enterprise Data Warehouse, it is important that you read and understand the information in Oracle Applications Concepts as well as the information in this guide. Concepts explains the technology, architecture, and terminology used here. The following people are the typical audience for this guide.

**Database Administrator**

Installs and configures the Oracle database and maintains database access controls. This person provides consultation on performance and is responsible for
monitoring growth and fragmentation of the production database and ensuring database backup and recovery.

**System Administrator**
Responsible for administering the development system. This person’s responsibilities include:

- Ensuring that hardware is correctly configured
- Installing, configuring, and maintaining operating and development software
- Ensuring that the system is backed up daily
- Designing and maintaining system security, for example, establishing system accounts

The system administrator provides first line support for problems with the development system and ensures that faults are quickly rectified. They may perform the setup and initial maintenance of the production system or advise the client’s operational staff on these tasks. The system administrator works with the project team to optimize system performance, install packaged applications environments, and convert data.

**Technical Specialist**
Responsible for designing, developing, unit testing, implementing, and maintaining the custom extensions for Oracle Applications. These extensions include, but are not limited to, interfaces, automated data conversions, reports, forms, and enhancements.

**Required Knowledge**
This guide requires a detailed technical understanding of the following products and tools.

- Oracle Applications Rapid Install and Oracle Applications
- AutoPatch
- Oracle Warehouse Builder
- Oracle Discoverer

This guide assumes you have a working knowledge of the following:

- The principles and customary practices of your business area.
- Oracle E-Business Intelligence applications and relational database concepts.
If you are not familiar with either the Oracle E-Business Intelligence applications or relational database concepts, Oracle suggests that you attend one or more of the training classes available through Oracle Education Services or Oracle University.

- The Oracle Applications graphical user interface.
  To learn more about the Oracle Applications graphical user interface, read the *Oracle Applications User’s Guide*.

**How to Use This Manual**

Oracle E-Business Intelligence Enterprise Data Warehouse Install Guide contains the following topics.

- Chapter 1, "Introduction" contains an overview of the Oracle E-Business Intelligence Enterprise Data Warehouse.
- Chapter 2, "Installation Tasks" contains step-by-step instructions for installing Oracle E-Business Intelligence Enterprise Data Warehouse.
- Chapter 3, "Upgrade Tasks" contains step-by-step instructions for upgrading Oracle E-Business Intelligence Enterprise Data Warehouse from Release 3.1 to Release 11i.6.

**Related Documents**

The Oracle E-Business Intelligence Enterprise Data Warehouse shares business and setup information with other Oracle Applications products.


Specific documentation that you will need to complete this installation include the following.

- *Oracle Warehouse Builder Installation Manual*
- *Oracle Discoverer 4.1 Installation and Upgrade Guide*
- *Oracle Discoverer 4.1 Administration Guide*
Other product documentation that complements Oracle E-Business Intelligence Enterprise Data Warehouse, includes the following:

- *Oracle Applications Release Notes*
- *Oracle Applications User’s Guide*
- *Installing Oracle Applications*
- *Upgrading Oracle Applications*
- *Maintaining Oracle Applications*
- *Oracle Applications Concepts*
- *Oracle Applications Flexfields Guide*
- *Oracle Applications System Administrator’s Manual*
- *Oracle Self-Service Web Applications Implementation Manual*
- *Oracle Workflow Guide*
- *Oracle Discoverer End User Layer Gateway: A Quick Start Guide*
- *Oracle Discoverer Readme file*
- *Oracle E-Business Intelligence Enterprise Data Warehouse Implementation Guide*
- *Oracle Business Intelligence System Implementation Guide*

If you plan to implement other products in Oracle E-Business Intelligence, see the following documentation:

- *Oracle Balanced Scorecard User Guide*
- *Oracle Balanced Scorecard Install Guide*
- *Oracle Sales Analyzer User Guide*
- *Oracle Sales Analyzer Install Guide*
- *Oracle Financial Analyzer User Guide*
- *Oracle Financial Analyzer Install Guide*
- *Oracle Activity Based Management User Guide*
- *Oracle Activity Based Management Install Guide*
Getting Help

Oracle Consulting Services and Oracle Support Services are the main sources of help for installing Oracle Applications.

Oracle Consulting Services
Oracle Consulting Services can help you:
- Determine machine size and database size required by Oracle Applications
- Install or upgrade Oracle Applications
- Implement Oracle Applications products
- Customize Oracle Applications products
- Install and configure multiple language support
- Develop custom applications for use with Oracle Applications
- Train users of Oracle Applications

Oracle Support Services
The Oracle Support Services web site at http://www.oracle.com/support offers registered Oracle MetaLink customers self-service support technologies, available 24 hours, 7 days a week. Oracle MetaLink provides information, such as technical libraries and forums, and services, like patch set downloads, BUG searches and TAR entry. If you contact Oracle Support Services, have this information available:
- Your CSI number
- Operating system number and versions
- Release of Oracle Applications you are installing and the versions of the Oracle Server and Oracle tools you are using
- Release of Oracle Applications you are upgrading from
- Description of the problem as well as specific information about any error messages you received
- Whether or not you have dial-in capability
- Output of the AD Configuration utility, contained in the adutconf.lst file. For additional information about AD Configuration, see Maintaining Oracle Applications
Conventions

The following typographical conventions are used in this manual.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monospaced text</td>
<td>Represents command line text. Type this text exactly as shown.</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Text enclosed in angle brackets represent a variable. Substitute an appropriate value for the variable text. Do not type the brackets.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Square brackets enclose optional items or indicate a function key. Do not type the brackets.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>/directory or \directory</td>
<td>A slash before a directory name indicates that it is a subdirectory. The path name may be either uppercase or lowercase.</td>
</tr>
<tr>
<td>$ or C:&gt;</td>
<td>Represents the command prompt. Your prompt may differ.</td>
</tr>
<tr>
<td>\</td>
<td>In examples of commands you type online, a backward slash at the end of the line of text signifies that you must type the entire command, including the portion of the text on the second text line, on one command line. Do not type the backslash.</td>
</tr>
</tbody>
</table>

The following special notes alert you to important information.

<table>
<thead>
<tr>
<th>Additional Information</th>
<th>Refers to portions of this manual, another manual, or the online documentation.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attention</td>
<td>Highlights important information that will help you use the system.</td>
</tr>
<tr>
<td>Note</td>
<td>Contains helpful hints and practical tips that can save time and make installation or other procedures easier.</td>
</tr>
<tr>
<td>Warning</td>
<td>Warns you about actions which, if not carried out properly, could be damaging or destructive to your operations.</td>
</tr>
</tbody>
</table>
Do Not Use Database Tools to Modify Oracle Applications or Enterprise Data Warehouse Data

*Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data Browser, database triggers, or any other tool to modify Oracle Applications or Enterprise Data Warehouse tables, unless we tell you to do so in our guides.*

Oracle provides powerful tools you can use to create, store, change, retrieve and maintain information in an Oracle database. If you use Oracle tools such as SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of your data and you lose the ability to audit changes to your data.

Because Oracle Applications and Enterprise Data Warehouse tables are interrelated, any change you make using an Oracle Applications form can update many tables at once. When you modify data using anything other than Oracle Applications forms, you might change a row in one table without making corresponding changes in related tables. If your tables get out of synchronization with each other, you risk retrieving erroneous information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications forms to modify your data, Oracle Applications automatically checks that your changes are valid. Oracle Applications also keeps track of who changes information. If you enter information into database tables using database tools, you may store invalid information. You also lose the ability to track who has changed your information because SQL*Plus and other database tools do not keep a record of changes.
About Oracle

Oracle Corporation develops and markets an integrated line of software products for database management, applications development, decision support and office automation, as well as Oracle Applications. Oracle Applications provides the E-Business Suite, a fully integrated suite of more than 170 software modules for financial management, Internet procurement, business intelligence, supply chain management, manufacturing, project systems, human resources and sales and service management.

Oracle products are available for mainframes, minicomputers, personal computers, network computers and personal digital assistants, enabling organizations to integrate different computers, different operating systems, different networks and even different database management systems, into a single, unified computing and information resource.

Oracle is the world’s leading supplier of software for information management, and the world’s second largest software company. Oracle offers its database, tools, and application products, along with related consulting, education and support services, in over 145 countries around the world.

Your Feedback

Thank you for using the Oracle E-Business Intelligence and this Install Guide.

We value your comments and feedback. This guide contains a Reader’s Comment Form you can use to explain what you like or dislike about the Oracle Business Intelligence System or this guide. Mail your comments to the following address or call us directly at (650) 506-3939.

Oracle E-Business Intelligence
Oracle Corporation
500 Oracle Parkway M/S3OP11
Redwood Shores, CA 94065
U.S.A.
Introduction

This chapter contains an overview of Oracle E-Business Intelligence Enterprise Data Warehouse Release 11i.6. This chapter includes the following topics.

- Overview of E-Business Intelligence on page 1-2
  - Overview of Enterprise Data Warehouse on page 1-2
- E-Business Intelligence Suite Architecture on page 1-4
  - Enterprise Data Warehouse Architecture on page 1-4
Overview of E-Business Intelligence

In becoming e-businesses, organizations have streamlined their internal processes to win new customers and to gain a larger share of their existing customers’ business. New, internet-enabled, enterprise application suites and electronic market places are reducing inefficiencies across supply chains while providing new opportunities to improve customer relationships. As organizations adopt these new solutions, the need to make decisions faster has also increased. To remain competitive, every organization must empower more people to make informed decisions, without the need for long approval or review cycles.

To meet this challenge, organizations must provide the relevant business information and analysis tools that every manager or project team needs to quickly understand what is happening, to be able to analyze alternatives, and to take action. Business intelligence applications are available to provide the data and analysis required to make these decisions, but most business intelligence products are not integrated with operational systems. Because the business processes underlying source applications are always changing, traditional business intelligence applications cannot easily gather the necessary data or transform it into useful management information.

The Oracle Business Intelligence System with the Enterprise Data Warehouse (EDW) provides a simple and powerful framework for delivering information, from internal applications and external sources, to end-users across the enterprise. EDW unlocks the value of information, held in operational systems, by automatically collecting, aggregating and transforming source data, to provide secure access and a unified view of the entire organization. With the Business Intelligence System applications, everyone has immediate access to accurate and timely data to make faster and more informed decisions, which leads to a positive impact on bottom line results.

Overview of Enterprise Data Warehouse

The Enterprise Data Warehouse (EDW) is a foundation technology for the Oracle E-Business Intelligence. This ready-to-run, end-to-end solution provides an open schema and extensible data warehousing architecture, powered by robust data warehousing tools. EDW:

- Gives users a unified view of the enterprise with its cross-functional analysis capabilities
- Leverages a common dimension model which enables seamless cross-functional analysis across the entire enterprise
Includes fact tables from 7 intelligence areas: Financials, Projects, Purchasing, Manufacturing, Marketing, Human Resources, and Supply Chain

Provides shorter time-to-benefit with its pre-defined enterprise schemas and hierarchies, and pre-built data collection and integration programs

EDW the enabling technology of Oracle E-Business Intelligence unleashes the power of e-business insight, not just information.
E-Business Intelligence Suite Architecture

E-Business Intelligence is designed to support a multi-tiered architecture.

The first tier, the database tier, provides the foundation technology. The database tier can be implemented as a transactional (OLTP) or a warehouse (OLAP) schema. The transactional schema provides users with real-time report data. The warehouse schema provides users with summarized data that supports more complex reporting and decision making. The type of schema you choose determines the type of content that is available to your users.

The second tier, the applications tier, provides the load balancing and business logic. It processes requests from the third tier (client tier) and sends results from the database tier to the client tier.

The third tier, the client tier, supports user activities such as reporting from the web, and administration.

If you are installing EDW, you are implementing E-Business Intelligence using the warehouse schema.

Additional Information: For more information on Oracle Applications and multi-tier architecture, see Oracle Applications Concepts.

Enterprise Data Warehouse Architecture

Physically, EDW divides the E-Business Intelligence architecture between two types of systems: one or more source systems and one target system.

A source system can be any Oracle Applications system, non-Oracle system running on an Oracle database, or legacy database application that provides data to the warehouse. You can use one or more source systems to provide data to the target system.

The target system is the runtime warehouse. There is only one target system. It integrates data from multiple source systems, transforms the data, and makes it available in a star schema design. The star schema design supports complex user reporting and decision making.
Source System Components
Source systems can be any Oracle Applications Release 10.7, 11, or 11i system; non-Oracle system running on an Oracle database; or legacy database application that provides data to the warehouse. Each source system must contain the following components.

- **Database links**: Database links are used to connect the source system to the warehouse and from the warehouse to the source system.

- **Interface tables**: For EDW, source system data is put into interface tables before it is pushed to the warehouse.

- **Collect programs**: Collect programs determine how to extract and transform source data for the warehouse. Collect programs use the database links to transfer data from the interface tables to the warehouse and from the warehouse to the source system.

- **Concurrent Manager**: The concurrent manager coordinates the processes generated by users’ requests to run various data-intensive programs.

- **Web Browser**: A web browser is used with Oracle Applications 11i source systems. This is only necessary on an Oracle Applications 11i source system.

These components must be installed and set up on each source system.

Target System Components
The target system is an Oracle Applications Release 11i.3 system (or higher) with an Oracle 8i database. The target system summarizes data from the various source systems into a data warehouse (from this point forward, this document will refer to the target system as the warehouse). The warehouse contains fact tables, dimension tables, APIs, and other supporting utilities and objects. It must also contain the following components:

- **Load programs**: Load programs use the EDW metadata to determine how to move data into the warehouse. Load programs transfer data from interface tables to warehouse schema.

- **Database Links**: Database links are used to connect the source system to the warehouse and from the warehouse to the source system.

- **EDW Metadata**: The EDW metadata defines the contents of the runtime warehouse: the facts, dimensions, and other objects. The loader engine uses the metadata define how to move data into the warehouse schema. The reporting and analytical tools also use the metadata.
- **Oracle Discoverer End User Layer**: The Oracle Discoverer End User Layer (EUL) is a schema that sits on the warehouse database. This schema is used to access the workbooks. Workbooks and the EUL must reside on the database tier of the warehouse.

- **Oracle Discoverer Workbooks**: Workbooks enable users to analyze the summarized data in the warehouse. Workbooks access data through the Oracle Discoverer EUL. Workbooks and the EUL must reside on the database tier of the warehouse.

- **Oracle Warehouse Builder Repository**: The Oracle Warehouse Builder (OWB) repository resides on the database tier of the warehouse. This repository stores the EDW metadata.

- **Interface tables**: For EDW, source system data is loaded into interface tables before it is transformed into the star schema on the warehouse.

- **Concurrent Manager**: The concurrent manager coordinates the processes generated by users’ requests to run various data-intensive programs.

- **Forms Server**: The Forms Server is automatically installed as part of the Oracle Applications 11i.3 (or higher) Rapid Install.

- **Oracle Discoverer 4i Web Client**: The Oracle Discoverer 4i Web Client is installed as a separate application. The client contains a web browser with the Oracle Discoverer Web Client plug-in that executes the workbooks.

- **Self Service Web Applications**: Self Service Web Applications is automatically installed as part of the Oracle Applications 11i.3 (or higher) Rapid Install.

- **Zip utility**: This utility is used to extract compressed files.

- **Oracle Warehouse Builder Client**: The OWB client provides front-end access to the OWB repository. The OWB client must be installed on a Windows NT machine. It is the recommended tool for viewing the EDW metadata.

- **Oracle Discoverer Bridge Client**: The Oracle Discoverer Bridge client is used to create the EUL from the EDW metadata. The bridge is installed as part of the typical Oracle Warehouse Builder install. The bridge can reside on the same physical machine as the OWB client.

- **Oracle Discoverer Administration Client**: The Oracle Discoverer Administration client is installed as a separate application. The client is used for administration of the Oracle Discoverer EUL. You use this client to import the EUL and configure security for Oracle Discoverer. The Oracle Discoverer Administration client must be installed on a Windows NT machine.
Web Browser: A web browser is used to view warehouse data.

Performance Management Framework components: The following is a list of the components that comprise the Performance Management Framework.

Presentation components: The Performance Management Graph Portlet allows end users to display graphs from the Performance Management Viewer reports. Through customization of this portlet the end user can choose a report and parameters for display.

The Performance Management List portlet allows end-users to view performance information from the personal homepage. Through customization of this portlet, an end user can choose measures and parameters. The actual values will display, with red color coding if the actual value falls outside of the tolerance range. The values of the measure are calculated through the processing of Alerts.

Through the E-Business Intelligence Performance Management Viewer, end users have access to a set of pre-built reports that are specifically tailored to intelligence users. These reports provide an intuitive user interface and features aimed at the novice end user. Note that previous versions of BIS used Oracle Reports to define and render reports. In this release, E-Business Intelligence uses its own Performance Management Viewer technology.

Through Oracle Workflow, users receive notifications. E-Business Intelligence uses notifications for alerting users to out of tolerance situations for measures with targets.

Definition components: The AK Repository is a metadata repository used for the definition of application common data. For E-Business Intelligence we use the AK Repository in defining Performance Management Viewer reports and Performance Measures. This definition contains layout information for the reports and establishes the source of actual values for both the reports and performance measures. For more information on defining new reports and measures, please see the E-Business Intelligence 3.1.1 Developer’s Guide.

The Performance Management Framework contains a set of forms to define performance measures and the dimension levels. These forms allow administration users to assign the dimensions, security, corrective actions and automated target retrieval. Note that a measure also needs setup in the AK repository to enable the retrieval of actual values. For more information on defining new measures, please see the E-Business Intelligence 3.1.1 Developer’s Guide.
Responsibilities: The following responsibilities are used for setting up the Performance Management Framework: Performance Management Framework (Full Access), Performance Management Framework (Targets Access), BIS Super User.

The following responsibilities contain Performance Management Viewer Reports: Purchasing Intelligence - Enterprise Data Warehouse, Supply Chain Intelligence - Enterprise Data Warehouse, Manufacturing Intelligence - Enterprise Data Warehouse.

Data components: For E-Business Intelligence Reports and Performance Measure, intelligence teams have built a set of Views on top of the EDW fact tables. These views are optimized for use by the Viewer Reports and Performance Measures.

The Performance Management Framework contains a set of forms for use in entering and maintaining target information on performance measures. This includes target values, tolerance ranges and target owners.

Processing components: Through the Performance Management Framework, administration users can schedule alerts and target users can subscribe to the notifications. Schedule Alerts will send notifications to target owners and update data for presentation on the performance measure portlet. Note that previous versions of BIS utilized Oracle Alerts to achieve the alerting functionality. In this release, E-Business Intelligence contains its own alerting technology.
This chapter describes how to install and configure the E-Business Intelligence with Enterprise Data Warehouse (EDW) Release 11i.6. This chapter covers the following topics.

- Overview of Installing EDW on page 2-2
- Verifying Prerequisites on page 2-4
- Installing the Enterprise Data Warehouse on Source and Target Systems on page 2-7
- Setting Up Database Links on page 2-19
- Installing Oracle Warehouse Builder Repository on page 2-22
- Loading EDW Metadata on page 2-33
- Check Validation Point on page 2-37
- Creating the EDW End User Layer and Importing EDW Workbooks on page 2-38
- Configuring Security on page 2-43
- Reallocate Tablespace on page 2-49
- Backup Source Systems and Warehouse on page 2-50
Overview of Installing EDW

This chapter describes how to install EDW. Some of the steps in this installation are dependent on particular hardware or software being installed and configured before you begin. Some of the steps are optional, must be performed in a particular order, or require that you validate the step with your implementation team.

To avoid unexpected delays in the installation, please read through this entire install guide and familiarize yourself with the install process before you begin.

Important: It is highly recommended that this install be performed by an Oracle Applications database administrator in cooperation with the implementation team.

The following table contains a checklist that you can use when installing EDW.

Table 2-1 Installation Steps

<table>
<thead>
<tr>
<th>Step</th>
<th>Location</th>
<th>Task List</th>
</tr>
</thead>
</table>
| ✔ Verifying Prerequisites on page 2-4 | Source Systems and Warehouse | ▪ Hardware Prerequisites  
▪ Software Prerequisites  
▪ Tablespace Prerequisites |
| ✔ Installing the Enterprise Data Warehouse on Source and Target Systems on page 2-7 | Source Systems and Warehouse | ▪ Apply Patches to Warehouse  
▪ Apply Patches to Source Systems |
| ✔ Setting Up Database Links on page 2-19 | Source Systems and Warehouse | ▪ Set Up Links from Warehouse to Source Systems  
▪ Set Up Links from Source Systems to Warehouse |
| ✔ Installing Oracle Warehouse Builder Repository on page 2-22 | Warehouse | ▪ Install OWB Repository. For more information, see the Oracle Warehouse Builder Installation Guide. |
| ✔ Loading EDW Metadata on page 2-33 | | ▪ Load EDW Metadata on page 2-33 |
### Table 2–1  Installation Steps

<table>
<thead>
<tr>
<th>Step</th>
<th>Location</th>
<th>Task List</th>
</tr>
</thead>
</table>
| ![ ] Check Validation Point on page 2-37 | Warehouse | - Check Validation Point, for more information see Oracle E-Business Intelligence Implementation Guide:  
  - Complete flexfield mapping (optional)  
  - Complete user defined attribute mapping (optional)  
  - Complete modification of metadata (optional) |

| ![ ] Creating the EDW End User Layer and Importing EDW Workbooks on page 2-38 | Warehouse | - Create the End User Layer  
  - Generate the EDW End User Layer EEX File, for more information see Oracle E-Business Intelligence Implementation Guide  
  - Import the EDW End User Layer EEX File |

| ![ ] Configuring Security on page 2-43 | Warehouse | - Grant Users/Responsibilities Access to Oracle Discoverer 4i User, or Administration Client. For more information, see the Oracle Discoverer documentation.  
  - Grant Users/Responsibilities Access to Business Areas  
  - Transfer EDW Discoverer 4i Contents to Windows NT Client with Oracle Discoverer 4i Administration Client  
  - Grant Users/Responsibilities Access to Workbooks  
  - Define Default Profile Options |

| ![ ] Reallocate Tablespace on page 2-49 | Warehouse | - Reallocate Tablespace |

| ![ ] Backup Source Systems and Warehouse on page 2-50 | Source Systems and Warehouse | - Backup data on source systems and warehouse (optional) |
Verifying Prerequisites

Before you begin to install EDW, you must verify that all hardware and software prerequisites have been met.

This section contains the following topics.

- Hardware Prerequisites
- Software Prerequisites
- Tablespace Prerequisites

Hardware Prerequisites

To successfully complete the install, you must have the following hardware available.

Source Systems
For information on hardware requirements for your 10.7, 11, and 11i source systems, see the installation documentation for the respective system.

Warehouse
For the hardware requirements for the database, see Oracle 8i Installation Guide.

For the hardware requirements and supported platforms for Oracle Discoverer, see Oracle Discoverer 4i Installation Guide.

For the hardware requirements for Oracle Applications 11i see Installing Oracle Applications 11i.

For the hardware requirements for Oracle Warehouse Builder Client, see Oracle Warehouse Builder Client Installation Guide. Note that the OWB Client is installed on the Administration Client and it requires an Oracle 8i home and must be installed on a Windows NT machine with at least 512 MB of RAM and 4 GB of virtual memory.

Software Prerequisites

To successfully complete the install, you must have the following software available on the source system and warehouse servers.
Source Systems
You must have one of the following standard source systems. For information on the standard install for each source system, see the appropriate installation documentation.

- Oracle Applications Release 10.7 with patch set D or higher
- Oracle Applications Release 11.0 with patch set 3 or higher
- Oracle Applications Release 11i with patch set 3 or higher

A minimum of 10 free Concurrent Manager slots is required to support EDW collection programs running on a source system. EDW collection programs on Oracle Applications source systems require a minimum of Internal Manager, Standard Manager and Conflict Resolution Concurrent Managers to be running.

Warehouse
The following software must be installed on warehouse:

- The warehouse database should be upgraded to Oracle RDBMS 8.1.7.1
- Oracle Discoverer 4i (4.1.38.16)
- Oracle Warehouse Builder Client patch 2.1.1.34.0 with Common Warehouse Metadata Transfer Wizard installed on a Windows NT machine with 512 MB of RAM and 1 Gigabyte of virtual memory.
- Oracle Warehouse Builder 2.1.1.34.3b patch must be installed on the Windows NT machine.
- Oracle Applications Release 11i.3 (or higher) Rapid Install with the ‘PROD’ option. For information on the standard installation for Oracle Applications Release 11i, see the appropriate installation documentation.
- Oracle Discoverer 4i Administration Edition client (4.1.38.10.0): The Oracle Discoverer Administration Client must be installed on a Windows NT machine with at least 256 MB of RAM

- Update your init.ora parameter file with the following initialization parameters:
  
  ```
  star_transformation_enabled = true
  bitmap_merge_area_size = 1048576
  create_bitmap_area_size = 8388608
  ```

  The bitmap_merge_area_size and create_bitmap_area_size parameters set to their default values, the ranges of values are operating system dependent.
Verifying Prerequisites

Tablespace Prerequisites

The following is the set of tablespace requirements for the database and OWB repository. Note that the database tablespace must be created on both the source systems and on the warehouse system. Note that the OWB repository tablespace must only be created on the warehouse system.

Database Schema Tablespace

Ensure that the default data and index tablespaces for the following database schemas each have enough free space on both the source systems and the warehouse system. The Oracle Applications tablespace naming conventions is `<PRODUCT ID><TABLESPACE TYPE>`, where the tablespace type is either “D” for data or “X” for indices. For example, BISX represents the index tablespace for BIS. The following is the set of tablespaces that require more than 10 MB of space.

<table>
<thead>
<tr>
<th>Intelligence Area</th>
<th>Index Tablespace (X)</th>
<th>Data Tablespace (D)</th>
</tr>
</thead>
<tbody>
<tr>
<td>BIS</td>
<td>100 MB</td>
<td>100 MB</td>
</tr>
<tr>
<td>FII</td>
<td>100 MB</td>
<td>100 MB</td>
</tr>
<tr>
<td>POA</td>
<td>60 MB</td>
<td>60 MB</td>
</tr>
<tr>
<td>BIM</td>
<td>50 MB</td>
<td>50 MB</td>
</tr>
<tr>
<td>OPI</td>
<td>50 MB</td>
<td>50 MB</td>
</tr>
<tr>
<td>ISC</td>
<td>50 MB</td>
<td>50 MB</td>
</tr>
<tr>
<td>ENI</td>
<td>50 MB</td>
<td>50 MB</td>
</tr>
<tr>
<td>HRI</td>
<td>50 MB</td>
<td>50 MB</td>
</tr>
</tbody>
</table>

OWB Repository Tablespace

Before you install EDW Oracle Warehouse Builder metadata and generate the EUL, you must also create a tablespace for your EDW metadata on the warehouse. This document refers to the USER_DATA tablespace as the default tablespace for the Oracle Warehouse Builder repository schema and EDW End User.

The tablespace size should be at least 200 MB.

The tablespace must be created manually because it is not created as part of the RapidInstall process.
Installing the Enterprise Data Warehouse on Source and Target Systems

Once you verify your prerequisites, you can begin to install the EDW patches to your warehouse and source systems.

Apply the patches to your systems in the following order:

1. Apply Patches to Warehouse on page 2-8
2. Apply Patches to Source Systems on page 2-12
Apply Patches to Warehouse

The first step in installing EDW is to apply the patches to the warehouse (also known as the target system). You must apply the following patches to the warehouse: 1779011 (only for Oracle Applications Release 11.5.3), 1914746, 1911211, 1842603, 1924975, 1863365 and 1865844.

**Warning:** Patches must be applied in the order they are presented in the steps below.

The EDW patches copy the Oracle Warehouse Builder metadata files edwrep.zip and edwmdl.zip to the $BIS_TOP/patch/115/import directory on your warehouse.

**To apply patches to the warehouse:**

1. In the warehouse, mount the appropriate EDW installation CD for your platform.

2. For each of the following servers, copy the patch files from the /<cdrom mount point>/115 directory on the CD into the directory on the server where you normally apply applications patches.
   - Administration server
   - Concurrent processing servers
   - Forms servers
   - Web servers

3. Unzip the files.

**Note:** Note: If you are running a 11.5.3 RapidInstall instance, you must splice ENI product into the instance before you apply the 1779011 patch. (E-Business Intelligence Enterprise DataWarehouse is dependent on the item dimension that resides in ENI product.)

Use adsplice to splice ENI into your 11.5.3 RapidInstall instances. For information on running adsplice, see Oracle Applications DBA documentation.

You do not need to splice ENI if you are running a 11.5.4 (or higher) RapidInstall instance.
4. Apply patch 1779011 (only for Oracle Applications 11i.3 release - you should skip this step if you are running Oracle Applications instance 11.5.4 or higher):
   a. Create the data (ENID, 50 MB) and index (ENIX, 100 MB) tablespace in your warehouse instance.
   b. Unzip 115/p1779011_11i_GENERIC.zip in your temporary patch directory.
   c. Open newprods.txt and replace the USER_DATA and USER_INDEX values with ENID and ENIX, respectively (as shown below).

   ```
   main_tspace=USER_DATA
   index_tspace=USER_INDEX
   temp_tspace=TEMP
   default_tspace=USER_DATA
   ```

   change to:

   ```
   main_tspace=ENID
   index_tspace=ENIX
   temp_tspace=TEMP
   default_tspace=ENID
   ```

   d. Copy the following text files into your $APPL_TOP/admin directory.
      - newprods.txt
      - eniprod.txt
      - eniterr.txt

   e. Run the adssplice utility to splice the ENI product into the instance.

   **Note:** Ensure that the ENID (50 MB) and ENIX (100 MB) tablespaces exist.

5. Apply patch 1914746 to the warehouse. This patch requires prerequisite patch 1698831 to be applied first. (You can skip this step if you are running Oracle Applications instance 11.5.4 or higher.) Use AutoPatch to apply the patch drivers in the following order (if they exist):
   - c1914746.drv (on all servers)
   - d1914746.drv (on administration server only)
   - g1914746.drv (on all servers)
6. Apply patch 1911211 to the warehouse. Use AutoPatch to apply the patch drivers in the following order (if they exist):
   ■ c1911211.drv (on all servers)
   ■ d1911211.drv (on administration server only)
   ■ g1911211.drv (on all servers)

7. Apply patch 1842603 to the warehouse. Use AutoPatch to apply the patch drivers in the following order (if they exist):
   ■ c1842603.drv (on all servers)
   ■ d1842603.drv (on administration server only)
   ■ g1842603.drv (on all servers)

8. Apply patch 1924975 to the warehouse. Use AutoPatch to apply the patch drivers in the following order (if they exist):
   ■ c1924975.drv (on all servers)
   ■ d1924975.drv (on administration server only)
   ■ g1924975.drv (on all servers)

9. Apply patch 1863365 to the warehouse. Use AutoPatch to apply the patch drivers in the following order (if they exist):
   ■ c1863365.drv (on all servers)
   ■ d1863365.drv (on administration server only)
   ■ g1863365.drv (on all servers)

10. Add a reference to the EDW Java configuration program by doing the following:
    a. Change to the $OA_HTML/bin/ directory.
    b. Open the appsweb.cfg file.
    c. In the file, go to the ‘JAR files for non FND ERP products’ line (archive 2 line).
    d. Go to the end of the line and add the following text. This text is necessary for EDW monitoring functionality.

        /OA_JAVA/oracle/apps/bis/jar/edwmontr.jar
11. Apply patch 1865844 to the warehouse. Please check this patch "readme" section for all prerequisite and post install steps for Performance Management and Self Service FrameWork. Use AutoPatch to apply the patch drivers in the following order (if they exist):
   - c1865844.drv (on all servers)
   - d1865844.drv (on administration server only)
   - g1865844.drv (on all servers)

12. On the administration server, run the AD Administration utility (ADADMIN) and from the Maintain Applications Database Objects menu, select the Compile APPS schema(s) option.

Additional Information: For information specific to your installation and details on the AutoPatch and AD Administration (ADADMIN) utilities, see Maintaining Oracle Applications, Release 11i for your platform.

Note: For the information on E-Business Intelligence Performance Framework installation see "Performance Management Framework Guide"
Apply Patches to Source Systems

After you apply the patches to the warehouse, you must apply the patches to each of your Release 10.7, 11, and 11i source systems.

For instructions on applying the patches to a specific release, see the following topics.

- Applying patches to Release 10.7 source systems
- Applying patches to Release 11.0 source systems
- Applying patches to Release 11i source systems

Applying patches to Release 10.7 source systems

To apply patches to a Release 10.7 source system, you must do the following:

- Upgrade Oracle RDBMS to 8.0.5 or higher. For instructions on how to upgrade your Oracle RDBMS system, see Installing Oracle RDBMS 8.
- Upgrade Oracle Applications to patch set D or higher. For instructions on how to upgrade your 10.7 system to patch set D, see Installing Oracle Applications 10.7.
- Apply the 10.7.INVD product patch set or higher. For instructions on how to apply this product patch set, see Oracle MetaLink.
- Apply patches to Release 10.7 source systems. Instruction on how to apply the patches to a Release 10.7 system are below.

To apply patches to Release 10.7 source systems:

1. Ensure that APPS user has ‘CREATE DATABASE LINK’ privilege.
2. Create two additional database loop links using the syntax below:

   sqlplus SYSTEM/<SYSTEM password>
   SQL>grant create database link to APPS;
   SQL>connect APPS/APPS;
   SQL>create database link APPS_TO_APPS connect to APPS identified by <APPS password> using '<10.7 instance connect string>’;
   SQL>create database link EDW_APPS_TO_WH connect to APPS identified by <APPS password> using '<10.7 instance connect string>’;

3. In the source system, mount the installation CD appropriate for your platform.
4. Copy the patch files from /<cdrom mount point>/107 to your database tier.
5. On each server, put the files in the directory you normally use to apply applications patches.

6. Extract the files.

---

**Caution:** Patches must be applied in the order they are presented in the steps below.

7. Apply the patch 1863399 to Oracle Applications Release 10.7 sources. Use AutoPatch to apply the patch driver (if it exists):
   - patch.drv
   - d1863399.drv

8. Run the AD Administration Utility, ADADMIN, on the administration server.

9. From the Maintain Applications Database Objects menu, select the Compile APPS schema(s) option.

---

**Note:** For information specific to your installation and details on the AutoPatch and AD Administration (ADADMIN) utilities, see Chapter 6, *Oracle Applications Installation Guide, Release 10.7* for your platform.

---

After you have applied the patches to all of your 10.7 and other source systems, proceed to Setting Up Database Links.

### Applying patches to Release 11 source systems

If you are applying patches to your Release 11 source systems, you must do the following:

- Upgrade system to 11.0.3 or higher. For instructions on how to upgrade your 11.0 system to 11.0.3, see *Installing Oracle Applications 11.0*.

- If you are using an Oracle 8.0.5.1 database on a Solaris 2x, you must apply the server-side patch 917987. The patch is located in `/<cdrom mount point>/interop directory. For information on how to apply the patch see the readme.917987 file.

- Apply the patches to your Release 11 source systems. Instructions on how to apply the patches are below.
To apply the patches to the Release 11 source systems:

1. On the source system, mount the installation CD appropriate for your platform.
2. Copy the patch files from `/<cdrom mount point>/110` to your administration server, concurrent processing server(s), forms server(s), and Web server(s).
3. On each server, put the files in the directory you normally use to apply applications patches.
4. Unzip the files.

**Caution:** Patches must be applied in the order they are presented in the steps below.

5. Connect to your SYSTEM schema using SQL*Plus and give the `CREATE DATABASE LINK` grant to APPS user using the following syntax:
   ```sql
   sqlplus SYSTEM/<SYSTEM password>
   SQL>grant create database link to APPS;
   SQL>exit;
   ```

6. Connect to your SYSTEM schema using SQL*Plus and give the `CREATE DATABASE LINK` grant to APPS user using the following syntax:
   ```sql
   sqlplus SYSTEM/<SYSTEM password>
   SQL>grant create database link to APPS;
   SQL>exit;
   ```

7. Connect to your SYS schema using SQL*Plus and give `EXECUTE` grant on `DBMS_SQL` package to APPS user using the following syntax:
   ```sql
   sqlplus SYS/<SYS password>
   SQL>grant execute on dbms_sql to APPS;
   SQL>exit;
   ```

8. Apply FND prerequisite patch 1971654 to your 11.0 source system by using AutoPatch to apply the patch drivers in the following order (if they exist):
   - c1971654.drv (on all servers)
   - d1971654.drv (on administration server only)
Installing the Enterprise Data Warehouse on Source and Target Systems

- g1971654.drv (on all servers)

**Attention:** Make sure that the TWO_TASK environment variable is defined in 11.0 source environment that you run Autopatch from.

9. Apply the EDW source patch 1863399 to your 11.0 source system by using AutoPatch to apply the patch drivers in the following order (if they exist):  
  - c1863399.drv (on all servers)  
  - d1863399.drv (on administration server only)  
  - g1863399.drv (on all servers)

10. Run the AD Administration Utility, ADADMIN, on the administration server.

11. From the Maintain Applications Database Objects menu, select the Compile APPS schema(s) option.

**Note:** For information specific to your installation and details on the AutoPatch and AD Administration (ADADMIN) utilities, see Chapter 5, *Oracle Applications Installation Guide, Release 11* for your platform.

After you have applied the patches to all of your 11.0 and other source systems, proceed to Setting Up Database Links.

**Applying patches to Release 11i source systems**

Use the following steps to apply patches 1779011 (only for Oracle Applications Release 11i.3), 1911211, 1842603, 1924975, 1710601 and 1863414 to your Release 11i.3 or higher sources.

**To apply patches to the Oracle Applications 11i source systems:**

1. In the source system, mount the appropriate EDW installation CD for your platform. The EDW patches are in following directory.

   /<cdrom mount point>/115
2. For each of the following servers, copy the patch files from the CD into the
directory on the server where you normally apply applications patches.

- Administration server
- Concurrent processing servers
- Forms servers
- Web servers

3. Unzip the files.

Caution: Patches must be applied in the order they are presented
in the steps below.

4. Apply patch 1779011 (only for Oracle Applications 11i.3 release - you should
skip this step if you are running Oracle Applications instance 11.5.4 or higher):

a. Create the data (ENID, 50 MB) and index (ENIX, 100 MB) tablespaces in
your 11i source instance.

b. Unzip 115/p1779011_11i_GENERIC.zip in your temporary patch directory.

c. Open newprods.txt and replace the USER_DATA and USER_IDX values
with ENID and ENIX, respectively (as shown below).

main_tspace=USER_DATA
index_tspace=USER_IDX
temp_tspace=TEMP
default_tspace=USER_DATA

change to:

main_tspace=ENID
index_tspace=ENIX
temp_tspace=TEMP
default_tspace=ENID

d. Copy the following text files into your $APPL_TOP/admin directory.

- newprods.txt
- eniprod.txt
- eniterr.txt
e. Run the adsplice utility to splice the ENI product into the 11i source instance.

5. Apply patch 1911211 to 11i source. Use AutoPatch to apply the patch drivers in the following order (if they exist):
   - c1911211.drv (on all servers)
   - d1911211.drv (on administration server only)
   - g1911211.drv (on all servers)

6. Apply patch 1842603 to 11i source instance. Use AutoPatch to apply the patch drivers in the following order (if they exist):
   - c1842603.drv (on all servers)
   - d1842603.drv (on administration server only)
   - g1842603.drv (on all servers)

7. Apply patch 1924975 to 11i source instance. Use AutoPatch to apply the patch drivers in the following order (if they exist):
   - c1924975.drv (on all servers)
   - d1924975.drv (on administration server only)
   - g1924975.drv (on all servers)

8. Apply patch 1710601 to your source instance. Use AutoPatch to apply the patch drivers in the following order (if they exist):
   - c1710601.drv (on all servers)
   - d1710601.drv (on administration server only)
   - g1710601.drv (on all servers)

9. Apply patch 1863414 to your source instance. Use AutoPatch to apply the patch drivers in the following order (if they exist):
   - c1863414.drv (on all servers)
   - d1863414.drv (on administration server only)
   - g1863414.drv (on all servers)

10. On the administration server, run the AD Administration utility (ADADMIN) and from the Maintain Applications Database Objects menu, select the Compile APPS schema(s) option.
Installing the Enterprise Data Warehouse on Source and Target Systems

Additional Information: For information specific to your installation and details on the AutoPatch and AD Administration (ADADMIN) utilities, see Maintaining Oracle Applications, Release 11i for your platform.
Setting Up Database Links

The EDW source instance patches create the following database links on each source system.

- EDW_APPS_TO_WH
- APPS_TO_APPS

To set up the source database links, drop the EDW_APPS_TO_WH link and recreate it. By recreating this link you are dropping the generic database link that was created on the source system when you applied the patch and are establishing a unique database link between the source system and the warehouse. You do not have to change the APPS_TO_APPS database link.

The EDW warehouse patches create the following database links on the warehouse.

- EDW_APPS_TO_WH
- APPS_TO_APPS

*Do not drop these links from the warehouse.*

To set up your warehouse database links, create a unique database link from the warehouse to each source system. The format for this new database link is shown below:

- EDW_WH_TO_<APPS>

For information on how to set up the required source and warehouse database links, see the following topics.

- Set Up Links from Warehouse to Source Systems on page 2-20
- Set Up Links from Source Systems to Warehouse on page 2-20
Set Up Links from Warehouse to Source Systems

You must set up a link (EDW_WH_TO_<APPS>) from the warehouse to each of your source systems. These links are used to link configuration information from the warehouse to the source systems.

Another pair of database links (EDW_APPS_TO_WH and APPS_TO_APPS) were already created on the warehouse. Do not drop or modify these links.

**Note:** When you set up your database links on the warehouse, you must ensure that you do not drop the APPS_TO_APPS or the EDW_APPS_TO_WH links.

To set up links from warehouse to source systems:

1. Sign on to the warehouse as APPS user using SQL*Plus. For example:
   
   ```
   > sqlplus apps/<apps password>@tst115
   ```

2. Create a database link (EDW_WH_TO_<APPS>) from the warehouse to the source systems, using the following syntax:
   
   ```
   > create database link <linkname> connect to <Oracle_Applications_Schema> identified by <password> using '<connect_string>';
   ```

   The following example illustrates how to create a link from the warehouse to two sources: edw110s and edw107s.
   
   ```
   > create database link EDW_WH_TO_edw110s connect to apps identified by apps using 'edw110s';
   > create database link EDW_WH_TO_edw107s connect to apps_appdemo identified by apps using 'edw107s';
   ```

3. Repeat steps 1 to 2 for each source system that you want to link to the warehouse.

Set Up Links from Source Systems to Warehouse

Once you set up database links from your warehouse to your source system, you must also set up links from the source systems to the warehouse. These links are used to collect data from the source systems to the warehouse.
To set up the source database links, you must drop the EDW_APPS_TO_WH link and recreate it. You do not have to change the APPS_TO_APPS database link.

**Note:** When you set up your database links on the Release 11i source systems, you must ensure that you do not drop the APPS_TO_APPS link. However, you must drop the EDW_APPS_TO_WH link, so you can recreate the link to point to the warehouse.

---

To set up links from source systems to warehouse:

1. Sign on to the source system as APPS user using SQL*Plus.
   For example:
   ```
   > sqlplus apps/<apps password>@edw110s
   ```

2. Drop the place-holder database link that was delivered with EDW using the following syntax.
   ```
   > drop database link EDW_APPS_TO_WH;
   ```
   You must drop this database link before you create a new link.

3. Create the database links from the source system to the warehouse environment, using the following syntax:
   ```
   > create database link EDW_APPS_TO_WH connect to <Oracle_Applications_Schema> identified by <password> using '<connect_string>';
   ```
   The following example illustrates how to connect a source system to a warehouse named tst115:
   ```
   > create database link EDW_APPS_TO_WH connect to apps identified by apps using 'tst115';
   ```

4. Repeat steps 1 to 3 for each source system.
Installing Oracle Warehouse Builder Repository

After you set up the database links between the warehouse and the source systems, you must install the Oracle Warehouse Builder (OWB) repository.

**Warning:** OWB’s code generator module does not support the use of Global Names. This does not effect standard EDW functionality, which operates independently of OWB’s code generator. If you plan on implementing a customized combination of standard EDW functionality and OWB generated code, it is highly recommended that you disable Global Names before installing Oracle Warehouse Builder.

The OWB repository resides in the database tier of the warehouse. It must be installed once on the database.

**Additional Information:** For more information on how to install the OWB client and repository, see the Oracle Warehouse Builder Installation Guide Release 2.1.1.34.

Complete the following step:
- Install OWB Repository on page 2-23
Install OWB Repository

The OWB Repository enables you to manipulate EDW metadata on the warehouse. You must install the OWB Repository on the database.

**Warning:** OWB’s code generator module does not support the use of Global Names. This does not effect standard EDW functionality, which operates independently of OWB’s code generator. If you plan on implementing a customized combination of standard EDW functionality and OWB generated code, it is highly recommended that you disable Global Names before installing Oracle Warehouse Builder.

The steps below briefly describe how to install the repository, for more detailed information on how to install the OWB Repository, see *Oracle Warehouse Builder Installation Guide* for release 2.1.1.34.3b.

**To install OWB Repository:**

1. Start the Oracle Applications BIS Repository Assistant from the Oracle Warehouse Builder program group. The Welcome window appears.
2. Choose the Next button to continue. The Create or Drop window appears.
3. Choose the Create a new BIS Repository option and choose the Next button to continue. The Server Information window appears.
4. Enter the applicable Host Name, Port Number, and Oracle SID information for the warehouse database in the fields provided. Choose the Next button to continue. The New or Existing Schema window appears.
5. Choose the Create and install into new BIS Repository Schema option and choose the Next button to continue. The Apps Username and Password window appears.
6. Enter the following information:

   **User Name:** apps
   **Password:** <apps user password>

   Choose the Next button to continue. The System Username and Password window appears.
7. Enter the following information:

**User Name:** system

**Password:** <system user password>

Choose the Next button to continue. The Tablespace window appears.
8. From the "Select the default tablespace for the BIS Repository objects" list of values, choose the default tablespace for EDWREP database schema.

9. From the "Select the tablespace for the users Temporary Segments" list of values, choose the temporary tablespace for EDWREP database schema. Choose the Next button to continue. The Password for EDWREP User window appears.
10. Enter the following information:

Password: <EDWREP password>

Re-enter Password: <EDWREP password>

Choose the Next button to continue. The Summary window appears.
The Summary window contains a list of all the selections you have made. Scroll through the list and verify that the OWB repository set up information is correct.

11. If the set up information is incorrect, choose the Back button until you reach the appropriate screen and re-enter the correct values. Choose the Next button repeatedly until you return to the Summary window.

12. If the set up information is correct, choose the Finish button. The Enterprise Data Warehouse schema is created and installed in your warehouse.

13. Install Oracle Warehouse Builder patch 2.1.1.34.3b by doing the following.
   a. Copy p1875839_211 GENERIC.zip from <CD-ROM>/interop to a temporary directory on your Windows NT OWB machine.
   a. Double-click on the file to uncompress the patch contents.
   a. Apply the patch following the instructions in the readme.txt file.
Loading EDW Metadata

After you install the OWB Client and Repository, you must load the EDW metadata into the OWB Repository.

Load EDW Metadata

Once you have installed the OWB Repository, you must load the EDW metadata into the repository.

To upload BIS EDW metadata:

1. Sign on to the warehouse environment as EDWREP using SQL*Plus and drop the sequence ‘cwmseq’ and truncate the table ‘cmpallclasses’ by using the following syntax:

   > sqlplus edwrep/edwrep@tst115
   SQL> drop sequence cwmseq;
   SQL> truncate table cmpallclasses;
   SQL> exit;

   Set an unlimited quota for user 'edwrep' on its default tablespace.

   Assuming that USER_DATA is default tablespace for user EDWREP run the following command:

   >sqlplus system/manager@tst115
   SQL> alter user EDWREP quota unlimited on USER_DATA;
   SQL>exit;
2. Copy the edwrep.zip file from the $BIS_TOP/patch/115/import/ directory to a temporary directory on your warehouse.

   **Important:** The EDWREP user is granted the "SELECT ANY TABLE" privilege, which allows the EDWREP user to read database dictionary tables. You must password protect the EDWREP user to prevent potential security issues.

   You can check for other users/roles which have the same "SELECT ANY TABLE" privilege by executing the following SELECT statement:

   sqlplus system/manager@<instance>
   SQL> select grantee from DBA_SYS_PRIVS where privilege='SELECT ANY TABLE';

   Ensure that any other users or roles with this privilege are also password protected.

3. Unzip edwrep.zip in the temporary directory.

4. Run the database import command (using the 8.1.6 (or higher) ORACLE HOME environment) to load the metadata:

   **Note:** Use the 8.1.6 (or higher) database import utility to load the EDW metadata.

   

   > imp <EDWREP user>/<EDWREP password>@<warehouse connect string>
   file=edwrep.dmp ignore=y buffer=20000000 commit=y constraints=n
   log=edwrep_imp.log

   The following example illustrates how to import data.
5. Check the edwrep_imp.log file for import errors. Ignore the warnings generated during metadata loader files import.

6. In the Oracle Warehouse Builder Client, connect to the newly created repository as edwrep database user. In the Project field, choose EDWPRJ.

7. The logon.properties file is automatically created in the OWB middle tier when you log in for the first time.

   **Important:** OWB metadata loaders will fail if you skip this step.


9. Upload OWB metadata using load.exe utility by doing the following:
   a. Change to the temporary directory where you unzipped the edwmdl.zip file.
   b. Check the README.txt file for instructions on how to run the load.exe utility.
   c. Run the load.exe utility in interactive or non-interactive mode.

   **Important:** Depending on the OWB middle tier server capacity it might take up to 8 hours to process all metadata loading jobs. So you might consider running it in the background.

d. Check the logs created for each uploaded mdl file.

10. Execute the following command in sqlplus in EDWREP schema:

    ```sql
    > sqlplus apps/apps @$BIS_TOP/patch/115/sql/EDWSYNCM.sql
    ```

    **Note:** In the above example the syntax “full=y” is for UNIX systems only. You can omit this portion of the syntax if you are using another operating system.
11. Analyze the CMPALLCLASSES table after the metadata has been imported to look for ways to improve your system performance. Run the following anonymous PLSQL block in apps schema:

```sql
> sqlplus apps/apps

declare
errbuf varchar2(200);
retcode varchar2(200);
begin
FND_STATS.GATHER_TABLE_STATS
(errbuf,retcode,'EDWREP','CMPALLCLASSES');
end;
/
```
Check Validation Point

At this point, you should contact your implementation team.

Important: All of the following steps are actually implementation steps. These steps are available in the Oracle E-Business Intelligence Enterprise Data Warehouse Implementation Guide, but are included here for your convenience.

These steps have been included in this document because they are necessary to begin to implement the E-Business Intelligence.

At this validation point, you must stop and verify whether or not the implementation team is planning to perform any of the following optional implementation tasks:

- Mapping flexfields (Accounting, Key, Descriptive)
- Mapping user-defined attribute
- Modifying EDW metadata

If the implementation team does plan to perform any of these tasks, stop and complete these tasks before proceeding.

For more information on how to implement EDW, see the Oracle E-Business Intelligence Implementation Guide.
Creating the EDW End User Layer and Importing EDW Workbooks

Important: The following steps are actually implementation steps and are also described in the Oracle E-Business Intelligence Enterprise Data Warehouse Implementation Guide. These steps are included here for your convenience.

Once you have set up the warehouse, you must install the EUL and workbooks. Complete the EUL and workbook installation steps in the following order.

1. Create the End User Layer on page 2-38
2. Generate the EDW End User Layer EEX File on page 2-39
3. Import the EDW End User Layer EEX File on page 2-42

Create the End User Layer

The first step in installing the EUL and workbooks is to create an applications-mode EUL that supports specific Oracle Applications functionality. This functionality is required to run EDW.

Note: Before creating the End User Layer you should identify the default tablespace for the EUL owner. Ensure that you have this tablespace available on the warehouse before you proceed. This document refers to the USER_DATA tablespace as the default tablespace for the End User Layer database schema in the examples.

To create the EUL:

Note: Before performing steps in this section, please verify that Discoverer 4i Administration Edition is installed on a Windows NT client PC.
1. Check that the storage parameter MAX_EXTENTS for the EDW EUL owner default tablespace is at least 150. If it is less than 150 you need to update MAX_EXTENTS storage parameter for the tablespace before creating End User Layer.

2. At the command prompt on the Windows NT client machine where you installed Oracle Discoverer 4i Administration Edition client, enter the following:

```bash
dis4adm.exe /CREATE_EUL /APPS_MODE /CONNECT system/<system password>@<database> /USER EDWEUL_US /PASSWORD <edweul_us password> /DEFAULT_TABLESPACE <edweul_us user default tablespace> /TEMPORARY_TABLESPACE <temporary tablespace> /SET_EUL_LANGUAGE <Language code> /APPS_GRANT_DETAILS apps/<apps password> /SHOW_PROGRESS
```

for example:

```bash
dis4adm.exe /CREATE_EUL /APPS_MODE /CONNECT system/manager@tst115 /USER EDWEUL_US /PASSWORD edweul /DEFAULT_TABLESPACE user_data /TEMPORARY_TABLESPACE temp /SET_EUL_LANGUAGE US /APPS_GRANT_DETAILS apps/apps /SHOW_PROGRESS
```

A window showing the EUL installation progress appears in a couple of seconds. Wait until the EUL installation is over before proceeding with the installation.

### Generate the EDW End User Layer EEX File

Next, you must generate the EDW EUL EEX file.

This step uses the CWM transfer wizard, which resides on the client tier of the warehouse, to generate an ASCII export file based on user-defined flexfields, attribute mappings and Applications Integrator set ups. You will later import this file into the database tier of the warehouse.

**Note:** The Windows NT machine that you use to generate the EEX file must have at least 512 MB of RAM and 1 Gigabyte of virtual memory.

**To generate the EEX file:**

1. Log on to the Oracle Warehouse Builder. The Project Name field is automatically populated with ‘EDWPRJ’.

2. Choose the OK button.
3. The BIS Configuration Assistant displays automatically. Choose the Close button to close the panel and show the OWB main page.

*Figure 2–10 Oracle Warehouse Builder: Utilities Launcher and CWM Transfer Wizard*

4. From the Utilities launcher, choose the CWM Transfer Wizard button. If you get the following error message, you must update your OWB preferences.

   “Cannot find c:\winnt\system32\cmd.exe. Please specify the correct directory in utility preference and try again.”

To update your OWB preferences, do the following:

a. In OWB navigate to Project > Preferences> Utility.

b. Choose CWM Bridge.

c. In the Full Path Command field, update the full path for cmd.exe.

d. Choose the Update button to save the change and close the window.

e. Re-start the “CWM Bridge” Transfer Wizard.
You will use the wizard to configure information to generate the EUL. When you use the wizard, ensure that Oracle Discoverer 4 is the selected target on the Source and Target Data Location window. Also ensure that the following values are provided for the CWM Transfer Wizard Parameters.

**Table 2–3  CWM Transfer Parameters**

<table>
<thead>
<tr>
<th>Transfer Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warehouse Builder User</td>
<td>EDWREP</td>
</tr>
<tr>
<td>Warehouse Builder Password</td>
<td>&lt;edwrep password&gt;</td>
</tr>
<tr>
<td>Warehouse Builder Connect String</td>
<td>&lt;DB hostname&gt;:&lt;TNS listener port&gt;:&lt;Oracle SID&gt;</td>
</tr>
<tr>
<td></td>
<td>For example, ap301sun:1521:edw115r</td>
</tr>
<tr>
<td>Warehouse Builder Project</td>
<td>EDWPRJ</td>
</tr>
<tr>
<td>OWB Exported Business Areas</td>
<td>All Business Areas</td>
</tr>
<tr>
<td>Metadata Transfer Includes</td>
<td>Warehouse Dimensional Entities Only</td>
</tr>
<tr>
<td>Discoverer EUL Owner</td>
<td>EDWEUL_US</td>
</tr>
<tr>
<td>Discoverer Schema Owner</td>
<td>APPS</td>
</tr>
<tr>
<td>Dimensional Reuse</td>
<td>True</td>
</tr>
<tr>
<td>Discoverer Output File</td>
<td>&lt;absolute path name&gt;.eex</td>
</tr>
<tr>
<td>Log Level</td>
<td>Information</td>
</tr>
</tbody>
</table>

Once you have verified the preceding information, you can proceed with the EUL import.

**Import the EDW End User Layer EEX File**

After you have generated the EEX file, you can use the Oracle Discoverer 4i Administration Edition client to import the EEX file from the client tier into the database tier of the warehouse.

**Additional Information:** See the *Oracle Discoverer 4i Administration Guide* for more information on how to import the EEX file.
Creating the EDW End User Layer and Importing EDW Workbooks

To import the EEX file:

1. Copy the <filename>.eex file to the Discoverer Administration Client.

2. Run Discoverer Administration Client and connect as the EUL owner. For example, EDWEUL_US.

3. Choose Import from the File menu.

4. Choose the Add button to add the generated <filename>.eex file that you want to import.

5. Ensure that you select the Import option shown in Figure 2–11, "Oracle Discoverer 4i End User Layer Import Parameters".

6. Choose the Start button. The import process begins.

7. After the import is over, choose the Finish button and wait until SQL regeneration is done.
Configuring Security

**Important:** The following steps are actually implementation steps and are also described in the *Oracle E-Business Intelligence Enterprise Data Warehouse Implementation Guide*. These steps are included here for your convenience.

Once you have installed the EUL and workbooks, you must use Oracle Discoverer 4i to configure security for your workbooks. Configuring security limits your users’ ability to access certain workbooks.

**Important:** The steps listed in this section are the mandatory security steps that you must define to complete the EDW install. Other ways of implementing security in the warehouse are explained in the *Oracle E-Business Intelligence Enterprise Data Warehouse Implementation Guide*. Please ensure that you verify with your implementation team the types of security that you want to implement.

To configure security using Oracle Discoverer 4i, complete these steps in the following order.

1. Grant Users/Responsibilities Access to Oracle Discoverer 4i User, or Administration Client on page 2-44
2. Grant Users/Responsibilities Access to Business Areas on page 2-45
3. Transfer EDW Discoverer 4i Contents to Windows NT Client with Oracle Discoverer 4i Administration Client on page 2-46
4. Grant Users/Responsibilities Access to Workbooks on page 2-48
Grant Users/Responsibilities Access to Oracle Discoverer 4i User, or Administration Client

The first step in configuring security is to grant your users and responsibilities access to Oracle Discoverer 4i. Grant the majority of your users access to Oracle Discoverer 4i Plus. Limit the number of users who are granted access to Oracle Discoverer 4i Administration Edition client.

**Important:** Throughout this section, be sure you are using the EDW EUL (edweul) user.

To grant access to Oracle Discoverer 4i Plus or Administration Client:

1. Log in to the Oracle Discoverer 4i Administration Edition client.
2. Connect to the database as the edweul owner (EDWEUL_US), for example: edweul_us/edweul@database
3. Check the default EUL by doing the following:
   a. Set the default EUL by choosing Select Tools > Options > Default EUL.
   b. Set the default to edweul owner. For example, EDWEUL_US.
4. Grant the user/responsibility access to Oracle Discoverer 4i Plus or Administration Client by doing the following:
   a. Choose Tools > Privileges.
   b. Select the responsibility. For example, BIS Super User.
   c. Give the responsibility access to either the 4i Plus or Administration Edition client by selecting the appropriate checkbox.
   d. Repeat steps a to c for each of the following responsibilities:
      - Financial Intelligence - Enterprise DataWarehouse
      - Manufacturing Intelligence - Enterprise DataWarehouse
      - Purchasing Intelligence - Enterprise DataWarehouse
      - Supply Chain Intelligence - Enterprise DataWarehouse
      - Human Resources Intelligence - Enterprise DataWarehouse
Grant Users/Responsibilities Access to Business Areas

Once you have granted the users/responsibilities access to Oracle Discoverer 4i, you must grant them access to the applicable business areas. You can also create new responsibilities if the ones provided do not meet your needs.

Table 2–4

<table>
<thead>
<tr>
<th>Responsibility</th>
<th>Business Area</th>
<th>Has Access To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financials intelligence - Enterprise Data</td>
<td>Payables</td>
<td>Access to Business Intelligence System</td>
</tr>
<tr>
<td>Warehouse</td>
<td>intelligence</td>
<td>Payables Business Area and Workbooks</td>
</tr>
<tr>
<td></td>
<td>business area</td>
<td></td>
</tr>
<tr>
<td>Financials intelligence - Enterprise Data</td>
<td>Revenue</td>
<td>Access to Business Intelligence System</td>
</tr>
<tr>
<td>Warehouse</td>
<td>intelligence</td>
<td>Receivables Business Area and Workbooks</td>
</tr>
<tr>
<td></td>
<td>business area</td>
<td></td>
</tr>
<tr>
<td>Financials intelligence - Enterprise Data</td>
<td>Project</td>
<td>Access to Business Intelligence System</td>
</tr>
<tr>
<td>Warehouse</td>
<td>intelligence</td>
<td>Projects Business Area and Workbooks</td>
</tr>
<tr>
<td></td>
<td>business area</td>
<td></td>
</tr>
<tr>
<td>Human Resources</td>
<td>Workforce</td>
<td>Access to Business Intelligence System</td>
</tr>
<tr>
<td>intelligence - Enterprise Data</td>
<td>Planning business area</td>
<td>Workforce Planning Business Area and Workbooks</td>
</tr>
<tr>
<td>Warehouse</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manufacturing Intelligence - Enterprise Data</td>
<td>Manufacturing</td>
<td>Access to Business Intelligence System</td>
</tr>
<tr>
<td>Warehouse</td>
<td>Intelligence</td>
<td>Manufacturing Business Area and Workbooks</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manufacturing Intelligence - Enterprise Data</td>
<td>Process</td>
<td>Access to Business Intelligence System</td>
</tr>
<tr>
<td>Warehouse</td>
<td>Manufacturing</td>
<td>Process Manufacturing Business Area and Workbooks</td>
</tr>
<tr>
<td></td>
<td>Intelligence</td>
<td></td>
</tr>
<tr>
<td>Manufacturing Intelligence - Enterprise Data</td>
<td>Operations</td>
<td>Access to Business Intelligence System</td>
</tr>
<tr>
<td>Warehouse</td>
<td>Intelligence</td>
<td>Operations Business Area and Workbooks</td>
</tr>
</tbody>
</table>
To grant users/responsibilities access to Business Areas:

2. Select the responsibility.
3. Grant the responsibility access to the business areas, as shown in the table above.
4. If the responsibility needs administration access to the business area, enable the Allow Administration checkbox.
5. Connect to Discoverer 4i Administration Edition as a valid Applications user with a valid responsibility (for example, "SYSADMIN:BIS Super User"), which has been granted access to Discoverer 4i Administration Client (see the section Grant Users/Responsibilities Access to Oracle Discoverer 4i User, or Administration Client on page 2-44) and validate your folders by choosing Choose View > Validate Folders.

For more information on how to grant access and define EUL security, see the Oracle Discoverer 4i Administration Guide.

Transfer EDW Discoverer 4i Contents to Windows NT Client with Oracle Discoverer 4i Administration Client

Discoverer 4i EUL contents and workbooks are delivered as EEX files that are staged by AutoPatch in the $/AU_TOP/discover/<LANG> directory. The installation of these EEX files is completely different from Discoverer 3i files. It...
Configuring Security

To transfer EDW Discoverer 4i contents to the Windows NT machine where Oracle Discoverer 4i Administration Edition client is installed:

1. Decide on one of the following methods to install Discoverer 4i EEX:
   - Mount your Oracle Applications AU_TOP to your Windows NT Discoverer Administration server and execute adupdeul.sh from the mounted $AU_TOP/discoverer directory.
   - Transfer $AU_TOP/discoverer directory and its contents (including subdirectories) to a temporary directory on your Windows NT Discoverer Administration server and execute adupdeul.sh from the temporary directory.

   **Important:** Ensure that the MKS Toolkit is installed on the Windows NT Administration server.

2. Load the EDW 11i.6 Discoverer 4i contents into the EDW EUL by doing the following:
   a. Open MS-DOS command prompt window.
   b. Change to the mounted directory / temporary directory where the $AU_TOP/discoverer directory contents are located.

3. Import EDW Discoverer 4i workbooks and extended End User Layer contents by executing the following command:

   ```sh
   sh adupdeul.sh connect=<APPS User>:<Valid Apps responsibility name>/<Apps user password>@<two_task> resp=<APPS responsibility name> gwyuid=applsyspub/pub fnndnam=apps seccgroup="standard" topdir=<top level directory where discoverer files are available> language=<comma separated list of language codes> eulprefix=<EUL prefix (for ex: EDWEUL)> eultype=EDW mode=driver exedir=<directory where discoverer executables are located> driver=c1863365.drv logfile=adupdeul.log
   ```
   For example:

   ```sh
d:temp sh adupdeul.sh connect=sysadmin:BIS Super User/sysadmin@tst115 resp="BIS Super User" gwyuid=applsyspub/pub fnndnam=apps seccgroup="standard" topdir=d:temp language=us eulprefix=EDWEUL eultype=EDW mode=driver exedir=d:orant\discvr4 driver=c1863365.drv logfile=d:\temp\adupdeul.log
   ```

**Upgrade Note:** To protect modified workbooks, users should make a local copy of the workbook that they want to modify and rename the workbook with ‘XX’ as the first two characters. Renaming the workbook ensures that the modified workbooks are not overwritten when a newer version of Oracle E-Business Intelligence is installed.

---

**Grant Users/Responsibilities Access to Workbooks**

Once the workbooks are installed in the database, you must grant users/responsibilities access to those workbooks.

**To grant users / responsibilities access to workbooks:**

1. Log in to the Oracle Discoverer 4i Plus (User) Edition

2. Connect as an Applications User with Applications responsibility that has administration access. See: "Grant Users/Responsibilities Access to Oracle Discoverer 4i User, or Administration Client". For example, MFG:BIS Super User.

3. For each workbook, perform the following steps:
   a. Open the workbook to which you need to grant other users/responsibilities access.
   b. Select File > Manage Workbooks > Sharing.
   c. Select User > Workbook tab.
   d. Repeat steps a to c for each of the responsibilities listed below:
      - Financial Intelligence - Enterprise DataWarehouse
      - Manufacturing Intelligence - Enterprise DataWarehouse
      - Purchasing Intelligence - Enterprise DataWarehouse
      - Supply Chain Intelligence - Enterprise DataWarehouse
      - Human Resources Intelligence - Enterprise DataWarehouse

4. Select the workbooks you need to grant access to and move them to the Shared section of the Share Workbook dialog box.
Define Default Profile Options

After you have granted your users/responsibilities access to the workbooks, you must define default profile options.

To define default profile options:

1. Connect to your warehouse Oracle Applications with ‘System Administrator’ responsibility:
   a. Navigate to Profile > System.
   b. Choose the Responsibility button and select the Global Warehouse Administrator responsibility.
   c. Run query for Profile ICX:%.

2. For the ICX: Discoverer End User Layer Schema Prefix profile option, enter edweul at the responsibility level. Do not overwrite the EUL definition at the site level.

3. Perform steps 1 to 2 for each of the responsibilities below:
   - Financial Intelligence - Enterprise Data Warehouse
   - Manufacturing Intelligence - Enterprise Data Warehouse
   - Purchasing Intelligence - Enterprise Data Warehouse
   - Supply Chain Intelligence - Enterprise Data Warehouse
   - Human Resource Intelligence - Enterprise Data Warehouse

Reallocate Tablespace

Before you can finish the installation and begin the implementation process, you must reallocate tablespaces to meet your unique system requirements.

When you reallocate tables, do the following:

- Create separate tablespaces for interface tables and star tables.
- Create separate tablespaces for large dimensions and facts.
- Don’t use default tablespace for any tables since the tables will be used by the loader engine to create the operation table at runtime.
Backup Source Systems and Warehouse

Congratulations! You have successfully completed installing EDW.

Once you complete the install, it is highly recommended that you backup the data on both your source and warehouse systems to ensure that you can always return to this fresh-install state. This step is optional.
This chapter describes how to upgrade and configure the E-Business Intelligence with Enterprise Data Warehouse (EDW) from Release 3.1 to Release 11i.6 (also known as Enterprise Data Warehouse Release 3.1.1). This chapter covers the following topics.

- Overview of Upgrading EDW on page 3-2
- Back Up Source Systems and Warehouse on page 3-3
- Verifying Prerequisites on page 3-4
- Upgrading the Enterprise Data Warehouse on Source and Target Systems on page 3-7
- Upgrading Oracle Warehouse Builder Repository on page 3-13
- Loading EDW Metadata on page 3-13
- Creating the EDW End User Layer and Importing EDW Workbooks on page 3-15
- Configuring Security on page 3-20
- Reallocate Tablespace on page 3-26
- Backup Source Systems and Warehouse on page 3-27
Overview of Upgrading EDW

This chapter describes how to upgrade EDW from Release 3.1 to Release 11i.6.

To avoid unexpected delays in the upgrade, please read through this entire section and familiarize yourself with the upgrade process before you begin.

**Important:** It is highly recommended that this upgrade be performed by an Oracle Applications database administrator in cooperation with the implementation team.

The following table contains a checklist that you can use when upgrading EDW.

<table>
<thead>
<tr>
<th>Step</th>
<th>Location</th>
<th>Task List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back Up Source Systems and Warehouse on page 3-3</td>
<td>Source Systems and Warehouse</td>
<td>Back Up Source Systems and Warehouse</td>
</tr>
<tr>
<td>Verifying Prerequisites on page 3-4</td>
<td>Source Systems and Warehouse</td>
<td>Hardware Prerequisites, Software Prerequisites, Tablespace Prerequisites</td>
</tr>
<tr>
<td>Upgrading the Enterprise Data Warehouse on Source and Target Systems on page 3-7</td>
<td>Source Systems and Warehouse</td>
<td>Apply Patches to Warehouse, Apply Patches to Source Systems</td>
</tr>
<tr>
<td>Upgrading Oracle Warehouse Builder Repository on page 3-13</td>
<td>Warehouse</td>
<td>Upgrading Oracle Warehouse Builder Repository</td>
</tr>
<tr>
<td>Loading EDW Metadata on page 3-13</td>
<td></td>
<td>Load EDW Metadata on page 3-13</td>
</tr>
<tr>
<td>Creating the EDW End User Layer and Importing EDW Workbooks on page 3-15</td>
<td>Warehouse</td>
<td>Create the End User Layer, Generate the EDW End User Layer EEX File, Import the EDW End User Layer EEX File</td>
</tr>
</tbody>
</table>
Before you begin your upgrade of EDW, ensure that you back up your source and warehouse instances.

This back up step is optional, but it ensures that you can always return to your previous system state.

### Table 3–1 Upgrade Steps

<table>
<thead>
<tr>
<th>Step</th>
<th>Location</th>
<th>Task List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring Security on page 3-20</td>
<td>Warehouse</td>
<td>■ Grant Users/Responsibilities Access to Oracle Discoverer 4i User, or Administration Client. For more information, see the Oracle Discoverer documentation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Grant Users/Responsibilities Access to Business Areas</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Transfer EDW Discoverer 4i Contents to Windows NT Client with Oracle Discoverer 4i Administration Client</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Grant Users/Responsibilities Access to Workbooks</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Define Default Profile Options</td>
</tr>
<tr>
<td>Reallocate Tablespace on page 3-26</td>
<td>Warehouse</td>
<td>■ Reallocate Tablespace</td>
</tr>
<tr>
<td>Backup Source Systems and Warehouse on page 3-27</td>
<td>Source Systems and Warehouse</td>
<td>■ Backup data on source systems and warehouse (optional)</td>
</tr>
</tbody>
</table>
Verifying Prerequisites

Before you begin to upgrade EDW, you must verify that all hardware and software prerequisites have been met.

This section contains the following topics.

- Hardware Prerequisites
- Software Prerequisites
- Tablespace Prerequisites

Hardware Prerequisites

To successfully complete the upgrade, you must have the following hardware available.

Source Systems
For information on hardware requirements for your 11i source systems, see the upgrade documentation for the system.

Warehouse
For the hardware requirements for the database, see Oracle 8i Installation Guide.

For the hardware requirements and supported platforms for Oracle Discoverer, see Oracle Discoverer 4i Installation Guide.

For the hardware requirements for Oracle Applications 11i see Installing Oracle Applications 11i.

For the hardware requirements for Oracle Warehouse Builder Client, see Oracle Warehouse Builder Client Installation Guide. Note that the OWB Client is installed on the Administration Client and it requires an Oracle 8i home and must be installed on a Windows NT machine with at least 512 MB of RAM and 4 GB of virtual memory.

Software Prerequisites

To successfully complete the upgrade, you must have the following software available on the source system and warehouse servers.
Source Systems
You must have the following standard source system. For information on the standard install for your source system, see the appropriate installation documentation.

- Oracle Applications Release 11i with patch set 3 or higher

A minimum of 10 free Concurrent Manager slots is required to support EDW collection programs running on a source system. EDW collection programs on Oracle Applications source systems require a minimum of Internal Manager, Standard Manager and Conflict Resolution Concurrent Managers to be running.

Warehouse
The following software must be installed on warehouse:

- The warehouse database should be upgraded to Oracle RDBMS 8.1.7.1
- Oracle Discoverer 4i (4.1.38.16)
- Oracle Warehouse Builder Client patch 2.1.1.34.0 with Common Warehouse Metadata Transfer Wizard installed on a Windows NT machine with 512 MB of RAM and 1 Gigabyte of virtual memory.
- Oracle Warehouse Builder 2.1.1.34.3b patch must be installed on the Windows NT machine.
- Oracle Applications Release 11i.3 (or higher) Rapid Install with the ‘PROD’ option. For information on the standard installation for Oracle Applications Release 11i, see the appropriate installation documentation.
- Oracle Discoverer 4i Administration Edition client (4.1.38.10.0): The Oracle Discoverer Administration Client must be installed on a Windows NT machine with at least 256 MB of RAM
- Update your init.ora parameter file with the following initialization parameters:

```
star_transformation_enabled = true
bitmap_merge_area_size = 1048576
create_bitmap_area_size = 8388608
```

The bitmap_merge_area_size and create_bitmap_area_size parameters set to their default values, the ranges of values are operating system dependent.
Tablespace Prerequisites

The following is the set of tablespace requirements for the database and OWB repository. Note that the database tablespace must be created on both the source systems and on the warehouse system. Note that the OWB repository tablespace must only be created on the warehouse system.

Database Schema Tablespace

Ensure that the default data and index tablespaces for the following database schemas each have enough free space on both the source systems and the warehouse system. The Oracle Applications tablespace naming conventions is `<PRODUCT ID><TABLESPACE TYPE>`, where the tablespace type is either “D” for data or “X” for indices. For example, BISX represents the index tablespace for BIS. The following is the set of tablespaces that require more than 10 MB of space.

<table>
<thead>
<tr>
<th>Intelligence Area</th>
<th>Index Tablespace (X)</th>
<th>Data Tablespace (D)</th>
</tr>
</thead>
<tbody>
<tr>
<td>BIS</td>
<td>100 MB</td>
<td>100 MB</td>
</tr>
<tr>
<td>FII</td>
<td>100 MB</td>
<td>100 MB</td>
</tr>
<tr>
<td>POA</td>
<td>60 MB</td>
<td>60 MB</td>
</tr>
<tr>
<td>BIM</td>
<td>50 MB</td>
<td>50 MB</td>
</tr>
<tr>
<td>OPI</td>
<td>50 MB</td>
<td>50 MB</td>
</tr>
<tr>
<td>ISC</td>
<td>50 MB</td>
<td>50 MB</td>
</tr>
<tr>
<td>ENI</td>
<td>50 MB</td>
<td>50 MB</td>
</tr>
<tr>
<td>HRI</td>
<td>50 MB</td>
<td>50 MB</td>
</tr>
</tbody>
</table>

OWB Repository Tablespace

Before you upgrade EDW Oracle Warehouse Builder metadata and generate the EUL, you must also create a tablespace for your EDW metadata on the warehouse. This document refers to the USER_DATA tablespace as the default tablespace for the Oracle Warehouse Builder repository schema and EDW End User.

The tablespace size should be at least 200 MB.

The tablespace must be created manually because it is not created as part of the RapidInstall process.
Upgrading the Enterprise Data Warehouse on Source and Target Systems

Once you verify your prerequisites, you can begin to upgrade the EDW patches to your warehouse and source systems.

Apply the patches to your systems in the following order:

1. Apply Patches to Warehouse on page 3-8
2. Apply Patches to Source Systems on page 3-11
Apply Patches to Warehouse

The first step in upgrading EDW from Release 3.1 to Release 11i.6 is to apply the patches to the warehouse (also known as the target system). You must apply the following patches to the warehouse: 1914746, 1911211, 1842603, 1924975, 1863365 and 1865844.

**Warning:** Patches must be applied in the order they are presented in the steps below.

The EDW patches copy the Oracle Warehouse Builder metadata file edwmdl.zip to the $BIS_TOP/patch/115/import directory on your warehouse.

To apply patches to the warehouse:

1. In the warehouse, mount the appropriate EDW CD for your platform.
2. For each of the following servers, copy the patch files from the /<cdrom mount point>/115 directory on the CD into the directory on the server where you normally apply applications patches.
   - Administration server
   - Concurrent processing servers
   - Forms servers
   - Web servers
3. Unzip the files.
4. Apply patch 1914746 to the warehouse. This patch requires prerequisite patch 1698831 to be applied first. (you can skip this step if you are running Oracle Applications instance 11.5.4 or higher). Use AutoPatch to apply the patch drivers in the following order (if they exist):
   - c1914746.drv (on all servers)
   - d1914746.drv (on administration server only)
   - g1914746.drv (on all servers)
5. Apply patch 1911211 to the warehouse. Use AutoPatch to apply the patch drivers in the following order (if they exist):
   - c1911211.drv (on all servers)
   - d1911211.drv (on administration server only)
6. Apply patch 1842603 to the warehouse. Use AutoPatch to apply the patch drivers in the following order (if they exist):
   - c1842603.drv (on all servers)
   - d1842603.drv (on administration server only)
   - g1842603.drv (on all servers)

7. Apply patch 1924975 to the warehouse. Use AutoPatch to apply the patch drivers in the following order (if they exist):
   - c1924975.drv (on all servers)
   - d1924975.drv (on administration server only)
   - g1924975.drv (on all servers)

8. Apply patch 1863365 to the warehouse. Use AutoPatch to apply the patch drivers in the following order (if they exist):
   - c1863365.drv (on all servers)
   - d1863365.drv (on administration server only)
   - g1863365.drv (on all servers)

9. Ensure that there is an EDW Java configuration program by doing the following:
   a. Change to the $OA_HTML/bin/ directory.
   b. Open the appsweb.cfg file.
   c. In the file, go to the ‘JAR files for non FND ERP products’ line (archive 2 line).
   d. If edwmontr.jar is not listed in the file, then go to the end of the line and add the following text. This text is necessary for EDW monitoring functionality.

   /OA_JAVA/oracle/apps/bis/jar/edwmontr.jar
10. Apply patch 1865844 to the warehouse. Please check this patch “readme” section for all prerequisite and post install steps for Performance Management and Self Service FrameWork. Use AutoPatch to apply the patch drivers in the following order (if they exist):
   - c1865844.drv (on all servers)
   - d1865844.drv (on administration server only)
   - g1865844.drv (on all servers)

11. On the administration server, run the AD Administration utility (ADADMIN) and from the Maintain Applications Database Objects menu, select the Compile APPS schema(s) option.

Additional Information: For information specific to your upgrade and details on the AutoPatch and AD Administration (ADADMIN) utilities, see *Maintaining Oracle Applications, Release 11i* for your platform.

Note: For the information on E-Business Intelligence Performance Framework installation see Oracle E-Business Intelligence Performance Management Framework and Performance Management Viewer User Guide.
Apply Patches to Source Systems

After you apply the patches to the warehouse, you must apply the patches to each of your Release 11i source systems.

For instructions on applying the patches to a specific release, see the following topics.

- Applying patches to Release 11i source systems

Applying patches to Release 11i source systems

Use the following steps to apply patches 1911211, 1842603, 1924975, 1710601 and 1863414 to your Release 11i.3 or higher sources.

To apply patches to the Oracle Applications 11i source systems:

1. In the source system, mount the appropriate EDW CD for your platform. The EDW patches are in the following directory.

   /<cdrom mount point>/115

2. For each of the following servers, copy the patch files from the CD into the directory on the server where you normally apply applications patches.

   - Administration server
   - Concurrent processing servers
   - Forms servers
   - Web servers

3. Unzip the files.

Caution: Patches must be applied in the order they are presented in the steps below.

4. Apply patch 1911211 to 11i source. Use AutoPatch to apply the patch drivers in the following order (if they exist):

   - c1911211.drv (on all servers)
   - d1911211.drv (on administration server only)
   - g1911211.drv (on all servers)
5. Apply patch 1842603 to 11i source instance. Use AutoPatch to apply the patch drivers in the following order (if they exist):

   - c1842603.drv (on all servers)
   - d1842603.drv (on administration server only)
   - g1842603.drv (on all servers)

6. Apply patch 1924975 to 11i source instance. Use AutoPatch to apply the patch drivers in the following order (if they exist):

   - c1924975.drv (on all servers)
   - d1924975.drv (on administration server only)
   - g1924975.drv (on all servers)

7. Apply patch 1710601 to your source instance. Use AutoPatch to apply the patch drivers in the following order (if they exist):

   - c1710601.drv (on all servers)
   - d1710601.drv (on administration server only)
   - g1710601.drv (on all servers)

8. Apply patch 1863414 to your source instance. Use AutoPatch to apply the patch drivers in the following order (if they exist):

   - c1863414.drv (on all servers)
   - d1863414.drv (on administration server only)
   - g1863414.drv (on all servers)

9. On the administration server, run the AD Administration utility (ADADMIN) and from the Maintain Applications Database Objects menu, select the Compile APPS schema(s) option.

**Additional Information:** For information specific to your upgrade and details on the AutoPatch and AD Administration (ADADMIN) utilities, see *Maintaining Oracle Applications, Release 11i* for your platform.
Upgrading Oracle Warehouse Builder Repository

Next, you must upgrade the Oracle Warehouse Builder (OWB) repository.

**Warning:** OWB’s code generator module does not support the use of Global Names. This does not affect standard EDW functionality, which operates independently of OWB’s code generator. If you plan on implementing a customized combination of standard EDW functionality and OWB generated code, it is highly recommended that you disable Global Names before upgrading Oracle Warehouse Builder.

Additional Information: For more information on how to install the OWB client and repository, see the Oracle Warehouse Builder Installation Guide Release 2.1.1.34.

**To upgrade the OWB Repository:**

1. Install Oracle Warehouse Builder patch 2.1.1.34.3b by doing the following.
   a. Copy p1875839_211_GENERIC.zip from <CD-ROM>/interop to a temporary directory on your Windows NT OWB machine.
   a. Double-click on the file to uncompress the patch contents.
   a. Apply the patch following the instructions in the readme.txt file.

Loading EDW Metadata

After you upgrade OWB, you must load the EDW metadata into the OWB Repository.

Load EDW Metadata

Once you have upgraded the OWB Repository, you must load the EDW metadata into the repository.
To upload BIS EDW metadata:


2. Upload OWB metadata using load.exe utility by doing the following:
   a. Change to the temporary directory where you unzipped the edwmdl.zip file.
   b. Check the README.txt file for instructions on how to run the load.exe utility.
   c. Run the load.exe utility in interactive or non-interactive mode.

   **Important:** Depending on the OWB middle tier server capacity it might take up to 8 hours to process all metadata loading jobs. So you might consider running it in the background.

   d. Check the logs created for each uploaded mdl file.

3. Execute the following command in sqlplus in EDWREP schema:

   ```sql
   > sqlplus apps/apps @$BIS_TOP/patch/115/sql/EDWSYNOM.sql
   ```

4. Analyze the CMPALLCLASSES table after the metadata has been imported to look for ways to improve your system performance. Run the following anonymous PLSQL block in apps schema:

   ```sql
   declare
   errbuf varchar2(2000);
   retcode varchar2(200);
   begin
   FND_STATS.GATHER_TABLE_STATS
   (errbuf,retcode,'EDWREP','CMPALLCLASSES');
   end;
   /
Creating the EDW End User Layer and Importing EDW Workbooks

Important: The following steps are actually implementation steps and are also described in the Oracle E-Business Intelligence Enterprise Data Warehouse Implementation Guide. These steps are included here for your convenience.

Once you have set up the warehouse, you must upgrade the EUL and workbooks. Complete the EUL and workbook upgrade steps in the following order.

1. Create the End User Layer on page 3-15
2. Generate the EDW End User Layer EEX File on page 3-16
3. Import the EDW End User Layer EEX File on page 3-19

Create the End User Layer

The first step in upgrading the EUL and workbooks is to create an applications-mode EUL that supports specific Oracle Applications functionality. This functionality is required to run EDW.

Note: Before creating the End User Layer you should identify the default tablespace for the EUL owner. Ensure that you have this tablespace available on the warehouse before you proceed. This document refers to the USER_DATA tablespace as the default tablespace for the End User Layer database schema in the examples.

To create the EUL:

Note: Before performing steps in this section, please verify that Discoverer 4i Administration Edition is installed on a Windows NT client PC.
Creating the EDW End User Layer and Importing EDW Workbooks

1. Check that the storage parameter MAX_EXTENTS for the EDW EUL owner default tablespace is at least 150. If it is less than 150 you need to update MAX_EXTENTS storage parameter for the tablespace before creating End User Layer.

2. At the command prompt on the Windows NT client machine where you installed Oracle Discoverer 4i Administration Edition client, enter the following:

   dis4adm.exe /CREATE_EUL /APPS_MODE /CONNECT system/<system password>@<database> /USER EDWEUL_US /PASSWORD <edweul_us password> /DEFAULT_TABLESPACE <edweul_us user default tablespace> /TEMPORARY_TABLESPACE <temporary tablespace> /SET_EUL_LANGUAGE <Language code> /APPS_GRANT_DETAILS apps/<apps password> /SHOW_PROGRESS

   for example:

   dis4adm.exe /CREATE_EUL /APPS_MODE /CONNECT system/manager@tst115 /USER EDWEUL_US /PASSWORD edweul /DEFAULT_TABLESPACE user_data /TEMPORARY_TABLESPACE temp /SET_EUL_LANGUAGE US /APPS_GRANT_DETAILS apps/apps /SHOW_PROGRESS

   A window showing the EUL upgrade progress appears in a couple of seconds. Wait until the EUL upgrade is over before proceeding with the upgrade.

Generate the EDW End User Layer EEX File

Next, you must generate the EDW EUL EEX file.

This step uses the CWM transfer wizard, which resides on the client tier of the warehouse, to generate an ASCII export file based on user-defined flexfields, attribute mappings and Applications Integrator set ups. You will later import this file into the database tier of the warehouse.

---

**Note:** The Windows NT machine that you use to generate the EEX file must have at least 512 MB of RAM and 1 Gigabyte of virtual memory.

---

**To Generate the EEX file:**

1. Log on to the Oracle Warehouse Builder. The Project Name field is automatically populated with ‘EDWPRJ’.

2. Choose the OK button.
3. The BIS Configuration Assistant displays automatically. Choose the Close button to close the panel and show the OWB main page.

Figure 3–1 Oracle Warehouse Builder: Utilities Launcher and CWM Transfer Wizard

4. From the Utilities launcher, choose the CWM Transfer Wizard button. If you get the following error message, you must update your OWB preferences.

   "Cannot find c:\winnt\system32\cmd.exe. Please specify the correct directory in utility preference and try again."

To update your OWB preferences, do the following:

   a. In OWB navigate to Project > Preferences > Utility.
   b. Choose CWM Transfer Wizard.
   c. In the Full Path Command field, update the full path for cmd.exe.
   d. Choose the Update button to save the change and close the window.
   e. Re-start the CWM Transfer Wizard.
You will use the wizard to configure information to generate the EUL. When you use the wizard, ensure that Oracle Discoverer 4 is the selected target on the Source and Target Data Location window. Also ensure that the following values are provided for the CWM Transfer Wizard Parameters.

### Table 3–3 CWM Transfer Parameters

<table>
<thead>
<tr>
<th>Transfer Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warehouse Builder User</td>
<td>EDWREP</td>
</tr>
<tr>
<td>Warehouse Builder Password</td>
<td>&lt;edwrep password&gt;</td>
</tr>
<tr>
<td>Warehouse Builder Connect String</td>
<td>&lt;DB hostname&gt;:&lt;TNS listener port&gt;:&lt;Oracle SID&gt;</td>
</tr>
<tr>
<td></td>
<td>For example, ap301sun:1521:edw115r</td>
</tr>
<tr>
<td>Warehouse Builder Project</td>
<td>EDWPRJ</td>
</tr>
<tr>
<td>OWB Exported Business Areas</td>
<td>All Business Areas</td>
</tr>
<tr>
<td>Metadata Transfer Includes</td>
<td>Warehouse Dimensional Entities Only</td>
</tr>
<tr>
<td>Discoverer EUL Owner</td>
<td>EDWEUL_US</td>
</tr>
<tr>
<td>Discoverer Schema Owner</td>
<td>APPS</td>
</tr>
<tr>
<td>Dimensional Reuse</td>
<td>True</td>
</tr>
<tr>
<td>Discoverer Output File</td>
<td>&lt;absolute path name&gt;.eex</td>
</tr>
<tr>
<td>Log Level</td>
<td>Information</td>
</tr>
</tbody>
</table>

Once you have verified the preceding information, you can proceed with the EUL import.

### Import the EDW End User Layer EEX File

After you have generated the EEX file, you can use the Oracle Discoverer 4i Administration Edition client to import the EEX file from the client tier into the database tier of the warehouse.

**Additional Information:** See the *Oracle Discoverer 4i Administration Guide* for more information on how to import the EEX file.
To import the EEX file:

1. Copy the <filename>.eex file to the Discoverer Administration Client.
2. Run Discoverer Administration Client and connect as the EUL owner. For example, EDWEUL_US.
3. Choose Import from the File menu.
4. Choose the Add button to add the generated <filename>.eex file that you want to import.
5. Ensure that you select the Import option shown in Figure 3–2, "Oracle Discoverer 4i End User Layer Import Parameters".

**Figure 3–2 Oracle Discoverer 4i End User Layer Import Parameters**

6. Choose the Start button. The import process begins.
7. After the import is over, choose the Finish button and wait until SQL regeneration is done.
Configuring Security

**Important:** the following steps are actually implementation steps and are also described in the Oracle E-Business Intelligence Enterprise Data Warehouse Implementation Guide. These steps are included here for your convenience.

Once you have upgraded the EUL and workbooks, you must use Oracle Discoverer 4i to configure security for your workbooks. Configuring security limits your users’ ability to access certain workbooks.

**Important:** The steps listed in this section are the mandatory security steps that you must define to complete the EDW upgrade. Other ways of implementing security in the warehouse are explained in the Oracle E-Business Intelligence Enterprise Data Warehouse Implementation Guide. Please ensure that you verify with your implementation team the types of security that you want to implement.

To configure security using Oracle Discoverer 4i, complete these steps in the following order.

1. Grant Users/Responsibilities Access to Oracle Discoverer 4i User, or Administration Client on page 3-21
2. Grant Users/Responsibilities Access to Business Areas on page 3-22
3. Transfer EDW Discoverer 4i Contents to Windows NT Client with Oracle Discoverer 4i Administration Client on page 3-23
4. Grant Users/Responsibilities Access to Workbooks on page 3-25
Grant Users/Responsibilities Access to Oracle Discoverer 4i User, or Administration Client

The first step in configuring security is to grant your users and responsibilities access to Oracle Discoverer 4i. Grant the majority of your users access to Oracle Discoverer 4i Plus. Limit the number of users who are granted access to Oracle Discoverer 4i Administration Edition client.

**Important:** Throughout this section, be sure you are using the EDW EUL (edweul) user.

To grant access to Oracle Discoverer 4i Plus or Administration Client:

1. Log in to the Oracle Discoverer 4i Administration Edition client.
2. Connect to the database as the edweul owner (EDWEUL_US), for example:
   ```
   edweul_us/edweul@database
   ```
3. Check the default EUL by doing the following:
   a. Set the default EUL by choosing Select Tools > Options > Default EUL.
   b. Set the default to edweul owner. For example, EDWEUL_US.
4. Grant the user/responsibility access to Oracle Discoverer 4i Plus or Administration Client by doing the following:
   a. Choose Tools > Privileges.
   b. Select the responsibility. For example, BIS Super User.
   c. Give the responsibility access to either the 4i Plus or Administration Edition client by selecting the appropriate checkbox.
   d. Repeat steps a to c for each of the following responsibilities:
      - Financial Intelligence - Enterprise DataWarehouse
      - Manufacturing Intelligence - Enterprise DataWarehouse
      - Purchasing Intelligence - Enterprise DataWarehouse
      - Supply Chain Intelligence - Enterprise DataWarehouse
      - Human Resources Intelligence - Enterprise DataWarehouse
Grant Users/Responsibilities Access to Business Areas

Once you have granted the users/responsibilities access to Oracle Discoverer 4i, you must grant them access to the applicable business areas. You can also create new responsibilities if the ones provided do not meet your needs.

<table>
<thead>
<tr>
<th>Responsibility</th>
<th>Business Area</th>
<th>Has Access To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financials intelligence - Enterprise Data Warehouse</td>
<td>Payables intelligence business area</td>
<td>Access to Business Intelligence System Payables Business Area and Workbooks</td>
</tr>
<tr>
<td>Financials intelligence - Enterprise Data Warehouse</td>
<td>Revenue intelligence business area</td>
<td>Access to Business Intelligence System Receivables Business Area and Workbooks</td>
</tr>
<tr>
<td>Financials intelligence - Enterprise Data Warehouse</td>
<td>Project intelligence business area</td>
<td>Access to Business Intelligence System Projects Business Area and Workbooks</td>
</tr>
<tr>
<td>Human Resources intelligence - Enterprise Data Warehouse</td>
<td>Workforce Planning business area</td>
<td>Access to Business Intelligence System Workforce Planning Business Area and Workbooks</td>
</tr>
<tr>
<td>Manufacturing Intelligence - Enterprise Data Warehouse</td>
<td>Manufacturing Intelligence</td>
<td>Access to Business Intelligence System Manufacturing Business Area and Workbooks</td>
</tr>
<tr>
<td>Manufacturing Intelligence - Enterprise Data Warehouse</td>
<td>Process Manufacturing Intelligence</td>
<td>Access to Business Intelligence System Process Manufacturing Business Area and Workbooks</td>
</tr>
<tr>
<td>Manufacturing Intelligence - Enterprise Data Warehouse</td>
<td>Operations Intelligence</td>
<td>Access to Business Intelligence System Operations Business Area and Workbooks</td>
</tr>
</tbody>
</table>
To grant users/responsibilities access to Business Areas:


2. Select the responsibility.

3. Grant the responsibility access to the business areas, as shown in the table above.

4. If the responsibility needs administration access to the business area, enable the Allow Administration checkbox.

5. Connect to Discoverer 4i Administration Edition as a valid Applications user with a valid responsibility (for example, "SYSADMIN:BIS Super User"), which has been granted access to Discoverer 4i Administration Client (see the section Grant Users/Responsibilities Access to Oracle Discoverer 4i User, or Administration Client on page 3-21) and validate your folders by choosing Choose View > Validate Folders.

For more information on how to grant access and define EUL security, see the Oracle Discoverer 4i Administration Guide.

### Transfer EDW Discoverer 4i Contents to Windows NT Client with Oracle Discoverer 4i Administration Client

Discoverer 4i EUL contents and workbooks are delivered as EEX files that are staged by AutoPatch in the $/AU_TOP/discover/<LANG> directory. The upgrade
of these EEX files is completely different from Discoverer 3i files. It requires MKS Toolkit installed on the Windows NT Oracle Discoverer 4i Administration server.

To transfer EDW Discoverer 4i contents to the Window NT machine where Oracle Discoverer 4i Administration Edition client is installed:

1. Decide on one of the following methods to upgrade Discoverer 4i EEX:
   - Mount your Oracle Applications AU_TOP to your Windows NT Discoverer Administration server and execute adupdeul.sh from the mounted $AU_TOP/discoverer directory.
   - Transfer $AU_TOP/discoverer directory and its contents (including subdirectories) to a temporary directory on your Windows NT Discoverer Administration server and execute adupdeul.sh from the temporary directory.

   **Important:** Ensure that the MKS Toolkit is installed on the Windows NT Administration server.

2. Load the EDW 11i.6 Discoverer 4i contents into the EDW EUL by doing the following:
   - a. Open MS-DOS command prompt window.
   - b. Change to the mounted directory / temporary directory where the $AU_TOP/discoverer directory contents are located.

3. Import EDW Discoverer 4i workbooks and extended End User Layer contents by executing the following command:

   ```shell
   > sh adupdeul.sh connect=<APPS User>:<Valid Apps responsibility name>/@<two_task> resp=<APPS responsibility name>
gwyuid=applsyspub/pub fnndnam=apps segroup="standard" topdir=<top level directory where discoverer files are available> language=<comma separated list of language codes> eulprefix=<EUL prefix (for ex: EDWEUL)> eultype=EDW
   mode=driver exedir=<directory where discoverer executables are located>
driver=c1863365.drv logfile=adupdeul.log
   ```

   For example:

   ```shell
d:c:\temp> sh adupdeul.sh connect="sysadmin:BIS Super User"/sysadmin@tst115
   resp="BIS Super User" gwyuid=applsyspub/pub fnndnam=apps segroup="standard"
topdir=d:\temp language=us eulprefix=EDWEUL eultype=EDW mode=driver
   exedir=d:\orant\discvr4 driver=c1863365.drv logfile=d:\temp\adupdeul.log
   ```

**Upgrade Note:** To protect modified workbooks, users should make a local copy of the workbook that they want to modify and rename the workbook with 'XX' as the first two characters. Renaming the workbook ensures that the modified workbooks are not overwritten when Oracle E-Business Intelligence is upgraded.

---

**Grant Users/Responsibilities Access to Workbooks**

Once the workbooks are upgraded in the database, you must grant users/responsibilities access to those workbooks.

**To grant users / responsibilities access to workbooks:**

1. Log in to the Oracle Discoverer 4i Plus (User) Edition

2. Connect as an Applications User with Applications responsibility that has administration access. See: 'Grant Users/Responsibilities Access to Oracle Discoverer 4i User, or Administration Client'. For example, MFG:BIS Super User.

3. For each workbook, perform the following steps:
   a. Open the workbook to which you need to grant other users/responsibilities access.
   b. Select File > Manage Workbooks > Sharing.
   c. Select User > Workbook tab.
   d. Repeat steps a to c for each of the responsibilities listed below:
      - Financial Intelligence - Enterprise DataWarehouse
      - Manufacturing Intelligence - Enterprise DataWarehouse
      - Purchasing Intelligence - Enterprise DataWarehouse
      - Supply Chain Intelligence - Enterprise DataWarehouse
      - Human Resources Intelligence - Enterprise DataWarehouse

4. Select the workbooks you need to grant access to and move them to the Shared section of the Share Workbook dialog box.
Define Default Profile Options

After you have granted your users/responsibilities access to the workbooks, you must define default profile options.

To define default profile options:

1. Connect to your warehouse Oracle Applications with ‘System Administrator’ responsibility:
   a. Navigate to Profile > System.
   b. Choose the Responsibility button and select the Global Warehouse Administrator responsibility.
   c. Run query for Profile ICX:%.

2. For the ICX: Discoverer End User Layer Schema Prefix profile option, enter edweul at the responsibility level. Do not overwrite the EUL definition at the site level.

3. Perform steps 1 to 2 for each of the responsibilities below:
   - Financial Intelligence - Enterprise Data Warehouse
   - Manufacturing Intelligence - Enterprise Data Warehouse
   - Purchasing Intelligence - Enterprise Data Warehouse
   - Supply Chain Intelligence - Enterprise Data Warehouse
   - Human Resource Intelligence - Enterprise Data Warehouse

Reallocate Tablespace

Before you can finish the upgrade and begin the implementation process, you must reallocate tablespaces to meet your unique system requirements.

When you reallocate tablespace, do the following:

- Create separate tablespaces for interface tables and star tables.
- Create separate tablespaces for large dimensions and facts.
- Don’t use default tablespace for any tables since the tables will be used by the loader engine to create the operation table at runtime.
Backup Source Systems and Warehouse

Congratulations! You have successfully completed upgrading EDW.

Once you complete the upgrade, it is highly recommended that you backup the data on both your source and warehouse systems to ensure that you can always return to this fresh-upgrade state. This step is optional.
## Index

**A**
- About Oracle, xvi
- Audience for This Guide, ix

**C**
- Clients
  - Oracle Discoverer Administration Client, 6
  - Oracle Discoverer Bridge Client, 6
  - Oracle Warehouse Builder Client, 6
- Configure Discoverer Security
  - Grant Access to Business Areas, 46, 23
  - Grant Access to EDW Workbooks, 48, 25
  - Grant Access to the User or Administration Edition, 44, 21

**E**
- Enterprise Data Warehouse Components
  - Source System Components, 5

**I**
- Install Discoverer Bridge, 37
- Install End User Layer and EDW Workbooks, 38, 15
  - Create the End User Layer, 38, 15
  - Import the End User Layer EEX File, 41, 18
- Install Oracle Warehouse Builder Repository, 23
- Install Release 11i Components Tasks
  - Apply Oracle BIS EDW Runtime Warehouse Patches, 8
- Installation

**O**
- Oracle Discoverer Administration Client, 6
- Oracle Discoverer Bridge Client, 6
- Oracle Warehouse Builder Client, 6

**R**
- Runtime Warehouse Components
  - Discoverer End User Layer & Workbooks, 6
  - Oracle Warehouse Builder Repository, 5

**S**
- Set Up Database Links
  - from Enterprise Data Warehouse to Oracle Applications Sources, 20
  - from Oracle Applications Sources to Runtime Warehouse, 20

**Y**
- Your Feedback, xvi

---

**Hardware Prerequisites, 4**

**Introduction, 1**